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2 Introduction, overview

This access control system manual contains information on installation, ope ration and the
controls of the electronic  access control system , consisting of the AirKey online
administration, app, cylinders, wall readers, padlocks and media for the access control
system .

The products and/or "AirKey online administration" user software described in the access
control system manual must exclusively be operated by personnel that are adequately
qualified for the corresponding task. Qualified personnel are  able to identify risk s when

handling products/systems and prevent potential hazards on the basis of their expertise.

2.1 General legal notes

> EVVA concludes the contract on the use of AirkKey and Xesar exclusively on the

basis of its General Terms of Business (EVVA -GTB) as well asi ts General Licensing
Conditions (EVVA -ALB) with regards to the software for the product. Please refer
to: https://www.evva.com/en/airkey/agb/ or

https: //www.evva.com/en/airkey/eula/

> We explicitly notify clients that the use of the access control system  subject to this
contract may trigger legal approval, reporting or registration obligations, in
particular with regard to data protection (e.g. a comprehen sive information
system), as well as grant the right of co -determination to staff in the event of use
on corporate premises. Customers, clients and end users shall be responsible for
product use in compliance with legal stipulations.

> The aforementioned inf  ormation must be observed and passed on to operators
and users as per the defined manufacturer product liability according to product
liability legislation. Non  -compliance releases EVVA from any liability.

> Not suitable in environments with children under 3 6 months due to a risk of
suffocation caused by small parts that may be swallowed.

> Any use deemed as non -compliant with the contract or as unintended use, any
repair work or modifications that have not been explicitly approved by EVVA as
well as all types  of incorrect servicing may cause malfunctions and are prohibited.
Any modifications that have not been explicitly approved by EVVA render claims
to liability, warranty as well as any separate guarantee claims void.

> Architects and advisory institutions are obliged to request all necessary product
information from EVVA and take into account all such information to comply with
obligations regarding information and instructions under the Product Liability Act.

Specialist retailers and installers must comply wit h the information in EVVA
documentation and they must pass on such information to customers, if
applicable.

> Please observe the corresponding international and national specifications in the
corresponding legislation, directives, standards and guidelines, p articularly


https://www.evva.com/en/airkey/agb/
https://www.evva.com/en/airkey/eula/
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regarding the requirements for escape routes and emergency exits, during project
management and installation of the locking components.

2.2 EVVA support

AirKey is a sophisticated and tested access control system. However, should you still
require support, please do not hesitate to contact your EVVA Partner.

A list of certified EVVA Partners is available on our homepage at
https://www.evva.com/uk -en/handlersuche/

Select the "Electro nic system partner" filter option to exclusively filter for EVVA partners
that offer electronic EVVA access control systems and can fall back on qualified specialist
expertise in this area.

Use the EVVA online form for certain types of support requests. W e currently provide the
online form for the following situations:

> You have exceeded the maximum attempts to enter credit codes.

> Unable to add credit

> AirKey online administration login page not available

> Login unavailable. Forgot user name and/or e-mail address .

> You have activatedt wo-factor authentication and do not have access to your
telephone number

Click the following link to access the online form:
https://www.evva.com/en/airkey/support/

For general information on AirKey visit our homepage at
https://www.evva.com/en/airkey/website/



https://www.evva.com/uk-en/handlersuche/
https://www.evva.com/en/airkey/support/
https://www.evva.com/en/airkey/website/
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2.3 Sig ns and symbols

Throughout the system manual, sequences of commands, individual commands or buttons
are illustrated as follows.

Example: Main menu  Media & persons - > Create person or buttons, suchas  Save .

Warning, risk of material damage in the event of non -compliance
with the corresponding safety measures.

Notices and additional information
Hints and recommendations
Error messages

Option Options

1000k

10
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The following figure provides an overview
communication methods. This is followed by descriptions of the individual components.

of AirKey | ocking components

and their

This bs how easy It Is
Alrkay s an offoctive and highly Innovative
actronic locking syster. Here, the mtemet and
aisting mobile phone networks are used 1o send
access authorisations across any distance.

All thvs Is made possible using smartphones ~
because with Airkey tha mobile s the key. This
allows to lock any Alrkey locking component using
amobile phona, The mobile phone additionally
forwards all the Information from the door 10 the
online adminkstration to keep the entire system up
to date.

Additional Identification media

Other Identification media, such as cards of key
tags can also be programmed using a smartphone
or coding station.

Alrkey cylinder + Alrkey wall reader
The cylinders and the wal reader are securlty products with
superior design, sultable for indoor and outdoor application that
can be unlocked with an authortsed smartphone or identification
medium, They save up to 1,000 events and are able 1o transfer
his Information to the online administration via the smarphone.

System overview | Unrestricted liberty

Workdwide data exchange
Mobile phone networks

or the Internet are used to
axchange securtty Informa-
tion between mobile phones
and the EVVA computar con-
tre across continents,

1Phone o Androld smartphones

Use the installed Airkey app 10 recaive access
authorisations and tum your smartphona Into an electronic
Key. During the locking process, the Alrkey cylinder status
data is temporarily saved in the app and transferred 1o the
‘onling administration upon the Hext contact

-

As socuro as online banking
End-to-end and SSL-encrypted data transfers.
Your data s protected on EVVA servers as par
the particularly strict, Austrian data protection
standards,

AirKey online administration
It allows you to grant access authorisations to unlock Alrkey
Tocking components and many more features, All you need fs
 computer or notebook with an installed browset, an Internet
cannection and KeyCredits.

All transferred data is secured as end

Figure 1: System architecture

recent encryption standards, encrypted from EVVA servers to

components

-to-end data according to the most

locking

11
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System overview | As secure as online banking
@ Highly secure data storage
ARl data is perfectly peotected on EVVA servers,
et stct Asian ey sandars
Privacy by design
Rk rovde sektions o chncal | ] A8 s sovd syl e acknd
safeguard compliance with data protection up several times at the facilities.
guidetnes. The technically sophisticated
design applies cutting edge securty mech- -
anisms and ensures seamiess securty at all Secure data tran:
stations in the background. Al transtorred data is secured as

As a result of central management, “digital keys'
can be backed up much better than with indvidual
protactie measures.

end-to-end data, as per the cutting
Here are the most important edge encryption standards.
security characteristcs:

As a result, it offers decryption
protection from EVVA servers
10 the Airkey locking companent.

[ -
= Installad encryption methods on modem
smartphones are an effective security
== =y et oy
\ SE The AirKey app can also be secured
" o= with an indivictual PIN code.
—=m
= 1f you lose your phone, the online admins-
Secure AirKey identification madia | .z tration ailows to immediately delote access
AirKey exclusively uses highly secure —= authorisations using an intemet browser.
NFC smart cards. @
W EECA
/ Worldwide, secure access.
T — Wherever you may be. the data exchange between your
g internet browser and EVVA servers is implemented vsing
Security at Alrkey locking components = TR a secure, protected https connection, a technology also
Thanks 10 tha use of cartfied secure elemants — used in oniine banking,
and decrypted - AlrKey sets new security benchmarks for locking - Highly secure ECDSA and AES encryption methods
nent for electronic additionally protect the Airkey system and its
components.
‘Access authorisations on compromised mobile phones of identification
B e e e
& =

An avent log for the last 1,000 access avents ensures seamiess
transparency.

The Airkey cylinder is equipped with driling protection, plug pulling
protection, rotary damper and rated break point on the outside thumb tum.

Figure 2: System overview i seamless security

3.1 Locking components

Locking components  (Airkey cylinders and wall readers) control access at the doors.
Depending on the authorisation, the locking component  enables or denies access.

3.1.1 AirKey cylinders

AirKey cylinders are battery  -operated locking components . They are certified for indoor
and outdoor use. Depending on the specific requirements, AirKey cylinders may also be
suitable for use in areas that are critical to security. AirKey cylinders boast mechanical

protection from vandalism and manipulation. Airkey cyl inders are suitable for installation
in fire doors and emergency exit doors *, providing they have been installed as per the
standards.

AirKey cylinders are available as half cylinders or double cylinders. Double cylinders are
available as one -sided or dou ble-sided access models. One -sided access models merely
feature electric authorisation components on the outside, whereas users must provide
authorisation on both sides with the double -sided access model. The electronic thumb turn

*

The FAP anti -panic function may be required for use in emergency exit and panic doors, depending on the
mortise lock. For this purpose, please observe the corresponding information and certificates from lock
manufacturers as well as the product code in the order.

12
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on the identification sid e rotates freely unless authorisation is provided. The black plastic
cap of the AirKey cylinder is the reader unit.

If users hold an authorised medium against the thumb turn, the cylinder engages briefly
to allow to turn the electronic thumb turn and opera te the lock. In this context, also observe
the information on  operating locking components

Note that when the door is closed, it is not automatically locked. The door
must be locked manually or alternatively using an additional device.

Please check if the AirKey cylinder you selected is suitable for your application. The AirKey
cylinder is available in various designs and configurations for this purpose.

The required data sheets as well as the product catalogue are available on our homepage
in the download section : https://www.evva.com/en/downloads l.
AirKey cylinders feature visual and acoustic signals. Please refer to the locking component

signals section for descriptions of the individual signals.

Follow the assembly manual enclosed with the packaging during assembly of the AirKey
cylinder ort he online assembly video clip at https://www.evva.com/en/airkey/website/

3.1.2 AirkKey h ybrid cylinder

The AirKey hybrid cylinder has the same characteristics as the AirKey cylinder. It can
therefore be used both indoors and outdoors as well as in safety -relevant areas.

Compared to the AirKey double cylinder with one -sided access, the AirKey hybrid cylinder
has a key module on the inside instead of the mechanical knob. This means that access

from the outside is via an electronic authorisation check and access from the inside via a
mechanical key.

Note that when the door is closed, it is hot automatically locked. The door
must be locked manually or alternatively using an additional device.

Please check whether the AirKey hybrid cylinder is suitable for your intended application.

The required data sheet as well as the product catalogue is available on our homepage in
the download section : https://www.evva.com/en/downloads /.

The AirKey hybrid cylinder has an optical and an acoustic signal. The explanation of the
various signals can be found under Locking components signals

Follow the assembly manual enclosed with the packaging during assembly of the AirKey
hybrid cylinder.

13
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3.1.3 AirKey lever ¢ ylinder

The AirKey lever cylinder is a battery -operated locking  component for use in lockers,
showcases, various containers, up to letterboxes both indoors and outdoors.

Access is via an electronic authorisation check on the outside. There is a lever on the inside

which locks the unit. Both unlocking and locking can only take place by manually turning
the AirKey lever cylinder after a successful authorisation check. Unlike the AirKey cylinder

and hybrid cylinder, the electronic knob on the identification side does not rotate freely
without authorization.

Please check whether the AirKey lever cylinder is suitable for your intended application.
The AirKey lever cylinder is available in different designs and configurations.

The required data sheets as well as the product catalogue are available on our homepage
int he download section : https://www.evva.com/en/downloads /.

The AirKey lever cylinder has an optical and an acoustic signal. The explanation of the
various signals can be found under Locking components signals

Follow the assembly manual enclosed with the packaging during assembly of the AirKey
lever cylinder.

3.1.4 AirKey padlock

The AirKey padlock is a battery -operated locking component for use in barrier systems,
roller shutters, depots and archive containers both indoors and outdoors.

Access is via an electronic authorisation check on the underside. A hardened steel shackle
is used for locking. Both unlocking and locking can only take plac e by manually turning the
electronic knob of the AirKey padlock after a successful authorization check.

Please check whether the AirKey padlock is suitable for your intended application. The
AirKey padlock is available in different designs and configurati ons.

The required data sheet as well as the product catalogue is available on our homepage in
the download section : https://www.evva.com/en/downloads /.

The AirKey padlock has an optical and an acoustic s ignal. The explanation of the various
signals can be found under Locking components signals

Follow the assembly manual enclosed with the packaging during assembly of the AirKey
padlock.

14
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Assembly  tools for the AirKey cylinder , hybrid cylinder, lever cylinder and
padlock

AirKey cylinders , hybrid cylinders, lever cylinders and padlocks are protect ed against
manipulation with a special mechanism. The electroni ¢ thumb turn can be removed with
special tools only. The required assembly tools for assembly, disassembly and those to

change the batteries are not enclosed with the AirKey cylinder as standard and for this
reason, they must be ordered separately.

The order code can be found in the AirKey product catalogue on our homepage in the
download area  https://www.evva.com/en/downloads/

3.1.5 AirKey wall readers

AirkKey wall readers are suitable for indoors and outdoors, surface -mounted or flush
installation and for areas critical to security.

Please use the dedicated seal enclosed with the product for use ou tdoors or in areas that
are exposed to water as well as in the event of surface -mounted installation. Observe the
information in the assembly manual.

AirKey wall readers are connected to the AirKey control unit using CAT5 cables (max.
100 m,loopmax.=2  Ohm) to supply them with power. The AirKey control unit is supplied
with power by the mains adapter and in the event of a power cut it features a data buffer

for a maximum of 72 h, providing the AirKey control unit had previously been in operation
for am inimum of six hours.

Please note that one AirKey control unit each is required to operate one
AirKey wall reader.

AirKey wall reader and control unit combinations can be used to operate electronic locking
elements, such as motorised cylinders, sliding and swinging doors, etc.

It is also possible to connect an external enable element (button) to the
control unit. Press it and the door opens as it would when accessing the door

using the reader unit. However, opening the door using the external release
element will NOT be logged. For security reasons please note that it is
consequently possible to access AirKey systems with third -party systems

without creating an entry in the event log.

Please check carefully to make sure the AirKey p roduct you selected is suitable for your
intended application/assembly situation. We have made the required data sheet , the
product catalogue  or assembly manual available in the download section of our homepage:
https://www.evva.com/en/downloads /.
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3.2 AirKey app
GETITON EVVA provides the AirKey app in the Google Play
» Google Play store/Apple App Store free of charge. « App Store

The AirKey app is required to operate locking component s with your smartphone. You can
also use your smartphone to add or update locking component s and media to your  access
control system . Most AirKey app features require an active Internet connection. However,

locking component s can also be operated offline.

Internet connections may incur extra charges. For this purpose, please note
your provider agreement.

3.3 Smartphones

Smartphones must meet the following minimum requirements for use in access control
system s:

> Smartphone featuring NFC or Bluetooth 4.0 (Bluetooth Low Energy/BLE)

> Operating system:

f  Android E from 5 .0 (NFC functionality available only)

f  Android E from 6.0 (NFC and Bluetooth)

Apple E fromiOS 10 (Bluetooth functionality available only)
> AirKey app from Google Play Store or Apple App Store

> Android smartphones require "Access telephone status and identity" authorisation

and location services must have been enabled.
List of smartphones compatible with access control system S
Please note that the smartphones 6compatibility depends on many factors and

not every smartphone that meets the minimum requirements can guarantee
compatibility. For this reason, EVVA comprehensively tests smartphones. For

a permanently up -to-date list of tested smartphone models suitable for use
with AirKey goto  List of compatible Smartphones

Enabling access to "Telephone status and identity” is necessary to
uniquely identify smartphones when adding them to a new access control
system .

Access to the location  is necessary because Android 6+ demands the

activation of location services to be able to scan for Bluetooth

components! If you would lik e to use Bluetooth functions in the AirKey app,

you must activate the location services as well as authorise the app to access

this data in the device settings. If you REFUSE to activate location services,

you can establish a connection to the components ( media and locking
component s) using NFC.

16


https://www.evva.com/en/airkey/compatible-smartphones/
https://play.google.com/store/apps/details?id=com.evva.airkey
https://itunes.apple.com/app/evva-airkey/id1167529896?mt=8

AirKey system manual version 2.5.0 | 25/10/2019 | Subject to misprints and technical changes

access to security

the "Access telephone status and identity" authorisation. iOS can also search
for Bluetooth components without having been granted access to location
services.

0 With Apple devices  (iOS operating system) there is no option to deactivate

3.4 AirKey media

As media currently availa  ble are tested smartphone models as well as cards, key tags,
combi keys and wristbands in various configurations, for example in combination with
Mifare DESFire EV1 technology.

The required data sheets as well as the product catalogue are available on our homepage
in the download section: https://www.evva.com/en/downloads /.

factory state. You must add media to your access control system  before

0 Media, such as cards, key tags, combi keys or wristbands are supplied in
being able to use them.

3.5 AirKey online administration

The AirKey online administration is EVVA & online software solution to manage access
control system s. The electronic access control system is compatible with all common
Internet browsers and operating systems and does not require local softw are installations
or dedicated IT infrastructure. EVVA is responsible for live operation and maintenance of

AirKey servers.

351 System requirements

> Operating systems:  Windows 7 (or higher), MacOS  10.10 (or higher), Linux

> Currently compatible with the following browsers:
Internet Explorer 9+, Chr ome 14+, Safari 6+, Firefox 52+

> JavaScript activated in browser
> Internet connection (1 MBit/s or faster)
> Optionally: USB port 2.0 for coding station

> Internet port 443 must be available

o You require avalid e-mail addresstoregisteran  AirKey access control system

3.6 EVVA KeyCredits

KeyCredits are required to operate access control system s, for instance to assign or change
access authorisations. KeyCredits are available either on the basis of quantity as quanti ty
credit (defined number of enabled changes to authorisations within an unrestric ted period
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of time) or on the basis of time (unrestricted number of enabled changes to authorisations
within a defined period of time). The matching KeyCredit package for every application is

available from specialist EVVA retailers, tailored to the size a nd dynamic characteristics of
your access control system . Please refer to the AirKey product catalogue for more detailed
information under https://www.evva.com/en/downloads /.

3.7 Coding station

Add or update locking component s and media to your  access control system  using the
optionally available coding station or a smartphone with maintenance authorisation. The

coding station can be activated using a local application. The local application brings the
advantage that it is compatible with current browsers and the coding station remains

available for updates of  locking component s and media after the browser has been closed

or users have logged off from the AirKey online administration.

The application sup ports the following browsers: Chrome, Firefox, Internet Explorer and
Edge.

3.7.1 System requirements

> USB port
> Java 7 or higher

> Coding station driver
The LED indicates the coding station is ready for operation once it has been connected.

Disconnect and reconnect if the coding station does not indicate it is ready for operation.
If necessary, re -install the coding station drivers.

3.7.2 Installing coding stations . See Section 4.5

3.8 Emergency power device

All locking component s feature an interface at the front of the locking component , below
the EVVA logo. Slightly press towards the inside on the left -hand side of the logo (near the
"E") and fold out on the right -hand side (near the "A") to access it. The installed interface

is intended for emergency power supply only and it is not required as part of normal

operation.

The emergency power device supplies locking component s with power to enable operation
in the event that the batteries have gone flat. For this purpose, connect the emergency

power device connection cable to the corresponding interface and then switch it on. No

other interactions with the emerge ncy power device are required. A medium with valid
authorisation is still required to operate the locking component

In this process, please note that this must be a permanent authorisation without a
restricted validity period. Please refer to the Emergency media _ section for more detailed
information. Immediately replace batteries after having used the emergency power device
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tooperate lockingcomponent s and subsequently update  locking component s to also enable
access with additional media. Please refer to the Replacing batteries and using the
emergency power device _ section for more detailed information.

Please note that the AirKey wall rea der cannot be supplied with power using
the emergency power device, it is supplied with power using an external
power supply in combination with the AirKey control unit.
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4 Commissioning

This section describes the first steps to commission the access control system
Visit our homepage at https://www.evva.com/en/airkey/website/ for a
screencast describing the first steps and commissioning of the access control
system s.

EVVA offers the following materials to support locking component  assembly:

> Assembly manual
EVVA provides non -verbal assembly manuals to support locking compone nt
assembly. They are enclosed with the packaging of the corresponding product or
available from our homepage at https://www.evva.com/en/downloads /.

> Videos :
We have provided assembly video clips on our hom epage at
https://www.evva.com/en/airkey/website/

4.1 Installing the AirKey app

> Download the AirKey app from the Google Play store | Apple App Store.
> Follow the AirKey app installation instructions on you r smartphone.
4.2 Registering to the AirKey online administration
Register with EVVA using a valid e-mail address to be able to use the AirKey online

administration.

> Open the following page in your browser: https://airkey.evva.com
The AirKey online administration login page opens.

> Select your preferred  language

> Click the AirKey registration = link .

‘access 1o security
AirKey | Login
Language: English -
User ID: | User D

Password: Password

Log in Forgot your password?

@ AirKey Support Legal notice OAirKey registration

Figure 3: "AirKey registration"link
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Complete the fields in the registration screen and register to Airkey.

> Select Business customer or Private customer

> Complete the fields in the form.
Fields highlighted by * are mandatory fields.

> Solve the Captcha - .

> Activate the tick box using the General Terms of Business (EVVA  -GTB) link and
the tick box at the General Licensing Conditions (EVVA  -ALB) - link. The s ystem

automatically opens the two corresponding PDF documents. You can also access
the documents at  https://www.evva.com/int -en/legal -notice/ .

EVVA) Airkey

S o e

Figure 4: Registeringto AirKey

If necessary, you can retrospectively change your customer data at any
time. For this purpose, click Access control system -> Customer data in
the main menu of the AirKey online administration.

> Click Register . The "Finish registration" application window opens.

> Once again check the  e-mail address you entered as we will send a confirmation
containing a registration link to this address.

> Click Cancel to cancel the process and correct your input if the e-mail address
shown was incorrect.

> Click Finish registration if the e-mail addressis correctand  complete the

process.

This completes the registration to AirKey.
You will receive an e-mail containing a confirmation link shortly.

Please check your e-mail adress and correct it if needed.

x Cancel [ Finish registration

Figure 5: Finishing registration
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The access control system  automatically generates one user ID and one registration link
and sends ittothe  e-mail address you stated as part of a registration e-mail .

> Openyour e-mail client. It will contain an e-mail from EVVA AirKey with the
subject line "EVVA AirKey registrat ion".

> Openthe e-mail and click the registration link. =

Keep this e-mail safe. If you need support, you require the unique user ID
and your customer number in the e-mail .

Fitzwilliam , welcome to AirkKey!

We are happy that you handle your key exchanges worldwide and in a matter of seconds by the internet.

To finish your Airkey registration, please specify a password by following the link: https://uat.airkey.evva.com/activation.html?
type=pendingacoactivation&activationCode=8VYLUPDY1SULFIHLQU4LOSXIB02SHBU O&language=en-UK

If you successfully finish your registration within 48 hours, the following data for you as an AirKey customer are valid:

Your customer number is: | NS vour user name: I

With kind regards,
your Airkey-Team

Click here to log in to the AirKey online administration https://airkey.evva.com Our terms and conditions and terms of licences can be found at
http://redirect.evva.com/airkey/en/agh

Figure 6: "EVVA AirKey registration” e-mail

The registration link in the e-mail is valid for 48 hours only.

An error message indicating an Invalid registration link will appear if the
registration link has expired or if it is invalid. In this case, you must re -
register.

The Welcome window opens after having clicked the registration link. This is where you
complete registration.

> Enter a personal password for the Air Key online administration.
The p assword must contain at least 6 characters and one numeral, as well as an
upper -case and a lower -case letter. An error message is output if your password
does not meet the specifications.

> Re-enter your password.

> Enteryourd ate of birth. It is used as a security question to confirm your identity
if you have forgotten your password.

We recommend you make your AirKey password as long as possible and do
not disclose it.
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You can now log on at any time on the Air

Airkey

Welcome to Airkey

ot o o o e ot v,

Pt oty e Aty ptmc s o . ot

() Airkey Support Aty rgleraion

Figure 7: Specifying an AirKey password to complete registration

Click Save - to finish registration once you have completed the mandatory fields
and both AirKey passwords match.

Login
You must log in to configure and manage the access control system
Open the following page in your browser https://airkey.evva.com

The AirKey online administration login page opens.

Select your preferred  language . You can change the language in the right
menu bar at any time within the active session.

Enter your user ID from the registration e-mail and the defined password and
confirm with Login. The access control system  home screen appears.

Key online administration login page. All you
need is the user ID from the registration e-mail and the previously defined AirKey
password.

Airkey o L mem o

#owove B accsscoumoussin I8 weonoetkons [ POTOCDIS S AVNSTRAIORS (@) HELP

-

]

oW | @ e o -

114 e smarghones 2cmn sand a ey’ 1 e e 4t

1 Maintenance task

Figure 8: Access control system  home screen

The home screen provides an overview of all data relevant to the system. Browse to any
functions and settings from this screen.

access to security

You have now completed the registration process and your access control system  has been
activated successfully.

-hand
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4.4 Interactive help

AirKey online administration starts the interactive help file after having logged in for the
first time to give you a tour of the program and explain the most important functions.

The example here is the "

which buttons to click and it will notify y

Figure 9: Interactive help

Add credit" function. The interactive help file will demonstrate

ou of any information you need to enter in the

fields. You can browse forwards and backwards within the interactive help file.

You can also close the interactive help file and

using the system manual.

If you have closed and would like to re

Add credit

48 Back

jenna, UTC +02:00

@

‘I 0 KeCodis
8 .

adit
P Sk | Lo

Add credit

2 Mair|

To recharge credit, hold your KeyCredit card ready and click "Add credit”. -

Figure 10: Interactive help

Help - > Interactive help

4.5 Installing coding stations

i topping up credit

get to know the AirKey online administration

AirKey coding stations are optional components used to add or update locking

components and media in access control s

The local coding station application brings

the advantage that it is compatible with current

browsers and the coding station remains available for updates of
media after the browser has been closed or users have logged off from the AirKey online

administration.

ystems.

locking component

access to security

-open the interactive help, select
in the main menu. Consequently you can restart
the interactive help as many times as you need, at any time.

s and
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The following browsers support communication between the AirKey online administration
and the coding station application: Chrome, Firefox, Internet Explorer and Edge.

Downloading and running the coding station application is browser
specific. The illu stration in your browser may differ from the depiction herein (Firefox).

Register and log in to the AirKey online administration (see Section

online administration

> Connectth e coding station to a USB port on your computer.

> Clickthe + icon inthe bottom right

- of the AirKey online

/ operating system -

Reqistering the AirkKey

administration

- ° 5 X
Figure 11: Coding station i installing the local application
> Subsequ ently click the "Install and start AirKey coding station application " = link

to install the local coding station

After having clicked the link you have 60

application .

? Coding station not configured

‘You can add or update AirKey locking components and
media to your Airkey system using the optionally Airkey
coding station

Install and start coding station application o

Figure 12: Installing and starting AirKey coding stations

seconds to open the  AirKey.jnlp file

(see continue step) . If the system times out, you must repeat the installation
from this step. Alternatively you can also save the Airkey.jnlp file and

manually open it.

The AirKey.jnlp file download dialogue appears. Open the file using the "Java(TM)

Web Start Launcher".
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Opening AirKey.jnlp

You have chosen to open:

4] AirKey,nlp
which is: JNLP File
from: https://uat.airkey.evva.com

What should Firefox do with this file?

© Openwith |Java(TM) Web Start Launcher (default) .

“) Save File

[”] Do this automatically for files like this from now on.

Figure 13: Opening the AirKey.jnlp file

> A connection to the coding station is established after having opened the file

>~ Connecting to coding station...
-
!
Have you installed and started the Airkey coding station?.

Note: Install Java on your computer first. You can then install and
start the AirKey coding station.

Figure 14: Establishing a connection to the coding station

> Select the available coding station (e.g. "OMNIKEY CardMan 5x21 -CLO" =) from
the list.

No coding station activated

Select a coding station for use.
02Micro CCID SC Reader 0 R
OMNIKEY CardMan 5x21 0

€ 2nikey cardian sxz1-cLo -

Figure 15: Selecting coding stations

> An AirKey icon E appears in the taskbar in the bottom left T the coding station
has been installed successfully and is active.

Figure 16: AirKey icon in the taskbar

The coding station application can also be installed and configured without
AirKey online administration, for example via the command line. (This option
requires advanced IT knowledge, especially working via the command line.)

> Save the coding station application via the link
https://airkey.evva.com/smkrest/inlp/newest -jar -file/
in the des ired directory.
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Cpening smk-web-start-container-11.10.10-production.jar =

You have chosen to oper:

|| smk-web-start-container-11.10.10-production.jar
which is: Executable Jar File (3,4 MB)

from: https://airkey.evva.com

Would you like to save this file?

Save File Cancel

Figure 17: Download coding  station application

> Open the command line and navigate to the directory where the coding

station application was previously stored.

In the command line, execute the command java -jar < FILENAME

CODINGSTATION - APPLICATION> to start the coding station appli
cation.

The AirKey icon appears in the task bar at the bottom right. Infor

mation about the configuration directory =, the working directory -

the available coding stations ® are displayed in the command line.

access to security

and

D:~AirKey Codierstation Applets“Onlineverwaltung>java —jar smk—web—start—contain
er—11.18_18-production. jar

2019-84-85 11:32:08.0887 [INFOllJConfig directory: C:\Users“f.dieners.airkey
2019-94-85 11:32:88.888 L[INFORlWork directory: D:wAirKey Codierstation prlet¢\0
nllneuelualtung\EUUﬂ AirKey

2017-84-@A5 11:32:88.225 [DEBUG] Sound active: true

20819-84-85 :32: [INFO1 ProxyBrowserfipplet started

2017-84—-85 :32: [INFO1 08 Mame: Windows 7

2819-84-85 :32: [INFO1 08 Uersion: 6.1

2819-A4-85 t32: [INFO1 08 Arc xBb

20819-84-85 :32: [INFO]1 Headless sync mode started

28178485 :32:88.795 [DEBUG[3HL action result: {"methodName':"cardReaderListC|
thanged", "paramete “:["HID Global OMNIKEY 5822 Smart Card Reader 81>

2819-84-85 11:32:8 797 [INFO1 Setting active peader to: HID Global OMNIKEY 5822
Smart Card Reader @

Apr B5, 2019 11:32:89 AM org.apache.coyote.AbstractProtocol init

INFORMAT ION: itializing ProtocolHandler [“http-hio—127.8.8.1-58743"]

Apr @5, 2019 11:32:87 AM org. apache.catalina.core.StandardService startInternal
INFORMATION: Starting service Tomcat

Apr B5, 2019 11:32:89 AM org.apache.catalina.core.StandardEngine startInternal
INFORMATION: Starting Servlet Engine: Apache Tomcat-7.8.88

Apr B5, 2019 11:32:89 AM org.apache.coyote.AbsztractProtocol start

INFORMATION: Starting ProtocolHandler [“http-hio—-127.8.8.1-568743"1

BN Administrator: CA\Windows\system32\cmd.exe - java -jar smk-web- start-container-ll.lCI.l[}-produ...lilﬁléj

Figure 18: Starting coding station application via command line

> The following parameters are available for the command java -jar

<FILENAME CODINGSTATION -APPLICATION> to configure the coding

station application via the command line:
1 -configDir <VALUE> : Changes the configuration directory to the
specified value. The default configuration directory depends on the
operating system used ( example Windows

%USERPROFILE% \ .airkey). The parameter must already be set at the

start of the coding station application.
1 -help : Opens the help and describes all possible parameters.

1 -version : Displays the version of the coding station application.
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1 -workDir <VALUE> : Chan ges the working directory to the specified
value. The default working directory is a folder "EVVA AirKey", which
is created when the coding station application is started, in the
directory of the downloaded coding station application. The parameter
must al ready be set at the start of the coding station application.

> To change the active coding station, the file config_customer.json  must be
modified in the configuration directory.
MName ’ Anderungsdatum Typ Grabe
|| airkey.marker 05.04,2019 12:37 MARKER-Datei 1 KB
| config_customer,jsen 05,04,2019 12:37 JSOMN-Datei 1 KB
Figure 19: Configuration directory coding station application
> To do this, change the entry next to "selectedCardReaderName" - tothe

designation of the desired coding station and restart the coding station
application. You will find the list of all available coding stations after
starting the coding stat  ion application -

J config_customer,json - Editor

Format Ansicht 7 o
[{"soundactive":true,"selectedCardReaderName” : "HID Global OMNIKEY 5022 Smart Card Reader 0"}

Datei  Bearbeiten

Figure 20: Configuration file coding station application

BN Administrator: C\Windows'\system32\cmd.exe - java -jar smk-web-start-container-11.10.10-predu... |£|E|éj

D:“AirKey Codierstation Applets*Onlineveruwaltung>java —jar smk-web—start—contain]
er—11.18.18-—production.jar —configDir Confi
2019-A4-@5 12:37:29,466 [INFO] Config directo
2819-84-85 12:37:2%,467 [INFO] Work directory
nlineverwvaltung~EUUA AirHey

2019-84-85 12:37:29,499 [INFO] Config file does not exist, writing default setti

ngs .
2019-A4-85 12:37:29,623 [DEBUG] Sound active: false

: Confi
:nfAirKey Codierstation Applets™0)

2819-84-A5
2819-A4-A5
2819-84-0A5
2819-A4-A5

12:37:30.178
12:37:30.178
12:37:30,.179
12:37:30.179

[INFO1 ProxyBrouserApplet started
[INFO1 0% MWame: Windows 7

[INFO1 0S8 Versi

[INFO1 0% Arc

2019-84-A5 12:37:38
hanged", "paramete
D SC Reader B'1>
fipr B5. 2019 12:37:-30 PM org.apache .coyote.fibstractProtocol init
INFORMATION: Initializing ProtocolHandler [“http—bhio—127.8.8.1-58743"1]
Apr B5. 2019 12:37:30 PM org.apache.catalina.core.8tandardService startInternal
INFORMATION: Starting service Tomcat
Apr B5, 2019 3 PM org.apache.catalina.core.StandardEngine startInternal
INFORMATION: i Servlet Engine: Apache Tomcat-7.8.88

r @5, 2019 12:37:30 PH org.apache .coyote _AbstractProtocol start
INFORMATION: Starting ProtocolHandler [“http—bhio-127.8.8.1-58743"]

[DEBU
s["HID G1

HL action pesult: {"methodName":"cardReaderListC
al OMHIKEY 5822 Smart Card Reader B",."02Micro CCI

2019-84-85 12:3?:33,13% [IHFOé;Headlegg sync mode started
1]

Figure 21: List of coding stations command line

The coding station application is automatically quit upon
computer. Create an application shortcut to the AirkKey.jnlp
the Auto start folder.

shutting down the
-File and save it in

Adding and removing locking components to a locking system as well as the
firmware update of locking components or the Keyring update of identification
media is only possible after logging in to the AirKey online administration.
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Updates of media and locking components are also possible after logging out
of the AirKey online administration or when the browser has been clos ed.

Configuring the local coding station application

Right -click the AirKey icon E to open the corresponding context menu.

Airkey anline administration...
Sound: on

About Airkey..
Exit

Figure 22: Configuring the coding station application

List of corresponding menu items:
> EVVA AirKey online administration . AirKey online administration login page
link
> Sound:on :A sound is indicated when updating component s using a coding
station. Audible feedback signals are recommended if the coding station is used

without AirKey online administration. With click on  Sound: on it will change to
Sound: off

> Sound : off : No sound will be indicated. With click on Sound: off it w ill change to
Sound: on

> EVVA AirKey product website :Linkto  Airkey product website

> Quit coding station application . quits the coding station a pplication.

4.6 Add credit

For this purpose, a KeyCredit card is required featuring a scratch field on the rear that
conceals a credit code.

> Onthe Home screen, selectthe Add credit button. -

> Alternatively click  Credit in the header.

(EVVA) Airkey - s o o

A b ooomame B wmineon Bmwco S ommen @ e

Home

=" &=

Figure 23: Credit
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> The screen shows an overview of your current credit and any previous top ups.

> Clickthe Add credit - button .

Credit
Quantity of credits
37 KeyCredit(s)
Time credit
o
Add credit
et protocsi (1 J0 |
Date, time Administrator (User ID) Credit code Details
30/05/2017 15:56 John Smith (13968155) 21L-9GGX-QS85-85YV-BZ5Q Credit added: 100 KeyCredit(s) added, new credit: 102 ol
KeyCredit(s)
19/10/2016 10:17 John Smith (13968155) JHWV-6SHY-LG33-QNDP-7TV6 Credit added: 10 KeyCredit(s) added, new credit: 10
KeyCredit(s)
Show 1 to 2 of 3 entries.

Figure 24: Add credit

> Enter the code you uncovered by scratching the KeyCredit -Card inthe " Add
credit" application window.

Add credit

Enter a credit code to add days or KeyCredits to your credit:

il

X cancel Qa

Figure 25: Entering credit codes

> Click Add credit

If you entered the code correctly, the system confirms your input and adds the credit.

[ Crediit for access control system “Fitzwilliam
Credit

Quantity of credits
17 KeyCredit(s)

Time crediit
None

/' You have recharged your creiits by 10 KeyCredit(s). ‘

| To dit
Credit protocol G’ Op-up cre
Date, time. Administrator (User ID) Credit code Result
28/06/2017 08:43 George Smith (74829583) 545F-N4X7-TTSQ-43LK-9XS) Credit added: 10 KeyCredit(s) added, new credit: 17 i

KeyCredit(s)

Show 1 to 2 of 2 entries

Figure 26: Add credit

4.7 Creating persons

Each person designated to be granted authorisation to the access control system  must be
created beforehand.

> Onthe Home screen, in the grey bar of the Media & persons section, click
Add -> Create person
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> Alternatively, go to the Home screen and select the

tile.
> You can also select
navigation bar

Media & persons

> Orselectthe "SendaKey " button and click
creating persons using smartphones.

> Complete the fields in the form.
Fields highlighted by * are mandatory fields.

> Click Save -.

Persons

- > Create person

Create new

access to security

-> Create person

in the left -hand

. This function allows

EVVR) Airkey
P—

Figure 27: Creating persons

The first name / last name / ID fields result in a unigue combination within

the access control system

If you additionally use the "ID" field, enter a value that ensures the
combination of first name and last name is unique (e.g. the staff number).
This makes se nse (most of all) in situations where there are persons with the

same first and last names.

The characters in the "First name", "Last name", "
"Streen" ,and "City" fields are restricted to a maximum of 50.
can be used for the "Postal code" field.

is 500 characters.

If the combination you entered already exists, the system will
exists".

> Check or correct your input.

> Click Save .

E-mail address

The character limit for texts in the

, "Telephone number
A maximumof 10  charac ters
"Comment " field

report "Person already

Once you have successfully created a person, the system shows a confirmation and a new

button appears below the name, Assign medium S
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+ o
Figure 28: Assigning media
You have now created the person in the access control system  and the user appears on
the person list.
47.1 Importing personal data

You can also create persons for AirKey in external files. For this purpose, you require a
corresponding CSV file  toimportintot he AirKey online administration

AirKey da L, A

#& HoME B accessconTRoLSYSTEM BB MEDWAGPersons [ proTocols B Al

Persons Imprt Expont

Figure 29: Importing person lists

The parameters of the personal data table are identical to the Creating persons section
in the AirKey online administration i.e., column A is the first name =, column B is the last
name - , column C is the ID ®, etc. The CSV file is imported into the AirKey online

administration in this sequence.
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AirKey

& HOME B ACCESS CONTROL SYSTEM

Create person

New person

Details

Details

o * First name
o Last name

e Identifier
oGEnder
eDahe of birth

Contact details

6 E-mail address
oTeIepthe number

&% MEDIA & PERSONS

First name
Lastname
Identifier
Please select +

DDMMYYYY

E-mail address

Telephone number

B rrotocols

Zis ADMIN

access to security

estreel Street
9 postcode | Postcode
@ city | City
m Country  Please select -
@ * Language for comespondence Deutsch -
@R&marﬁs
Comment
Figure 30: Importing persons i persons list
E-d®9-e-|s AirKey - Import persons - Excel template 2.5xlsx - Microsoft Excel - B %
Start  Einfigen  Seitenlayout  Formeln  Daten  Uberprifen  Ansicht  Entwicklertools ©o@Q o @ =
M9 v (- #=| Person 2 = duplicate! ~
a
-
O~ ©® s © c ©Oo O ¢ 6 F © ¢ O © 1 @ @k B ® ™
1) First name | 2) Lastname | 3) Identifier |4) Gender | 5) Date of birth |6) E-mail address | 7) Telephone number | 8) Street | 9) Postal code | 10) City | 11) Country |12) Languagefor |  13) Comment
(mandatory, (mandatory, | (max.50char.) [ (M /F) | (YYYY-MM-DD) | (max.50characters} | (to be formated astext, | {max.50char) | (max.10char) | (max.50 (see Excel correspondence | (max. 250 characters)
max.50char.) | max. 50 char.) max. 50 characters) characters) | comment) (mandatory, see
1 Excel comment)
2
3 Smallest Record en-UK
P
5 Anna Otker AO F 1997-12-20 emaill@gmx.com |+43 664 123 456 789 Schone Str. 1 1130 Wien AUT de-DE Special I:har.:f],ii B
6 Jan Cesky 1. M 1964-05-17 +420 111222 333 444 |Pfipotoéni 13 10100 Prag czE es-CZ Special char.: G, i, F,y
7
8 [Dany DeVito DD en-UK Person 1
9 |Dany deVito Dd en-UK Person 2 = duplicate!
10
11 |Attention!  |Manual line breaks are not allowed! en-UK
1
4 4 » v | Import persons <73 - KAl i
Bereit | 3 | Anzahl: 10

Figure 31: Importing persons

CSV file properties with personal data for import:

i fields on the persons list

> The first row is always ignored. For this reason, we recommend you enter the field
names in this row to make identification of the remaining data easier. You can also
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leave the first row empty. However, it must not contain personal data because that
would then not be imported.

Empty rows or rows featuring spaces and tab stops (blanks) only are also ignored.
Consequently, you can leave any number of blanks if you would like to add more
transparency to your CSV file.

Each file must feature all 13 fields (attr ibutes) shown in  Figure 30.
Fields are each separated by a semicolon.

There are a mere three mandatory fields: first name (field 1), last name (field 2)
and language for correspondence (field 12).

If the remaining fields do not feature data, they must still be available as empty
fields (;;).

The gender (field 4) must exclusively contain M (for male)or F (for female ) or be
left empty. This  applies to all languages and M and F must be used in capital letters
only.

Enter the date of birth (field 5) in YYYY -MM-DD format (e.g. 1997 -12-20).

The e-mail address (field 6) must contain the @ character including other charac ters
or be empty.

The coun try for the address (field 10) must contain the 3 -digit 1SO 3166 -1 code

(ALPHA -3 column) of the corresponding country or be left empty. Enter the code in
capitals only. Examples: A UT, DEU, GBR, NLD, SWE, FRA, ITA, ESP, PRT, CZE, SVK,
POL, etc.

The field to specify the language for correspondence (field 12) is a mandatory field

and must feature the ISO code for the language. Keep to the exact spelling with
upper/lower -case letters. Only the following codes are accepted . ¢s-CZ, de -DE, en -
UK, es-ES, fr -FR, it -IT, nl -NL, pl -PL, pt -PT, sk-SK, sv -SE.

A person to be imported is shown as a person that is already available ( L. icon) if
the first name + last name + ID (fields 1 -3) combination already exists in the AirKey
online administration, even if the remaining fields (fields 4 -13) are different. These
persons are not imported. Please note that the names are case insensitive (e.g.
"Danny; DeVito;D D" and " Danny; deVito;D d" are considered the same person and
only the first person will be imported ).

Persons are interpreted as duplicates within the CSV file if the combination of first

name + last name + ID (fields 1 -3) already exist s once, even if the remaining fields
(fields 4 -13) are different. In this case, merely the first row is shown with a certain
combination before it is imported. Any further duplicates are ignored and not shown

in the table of persons to be imported.

Faulty rows in the CSV file are highlighted by the X icon and added to the tool tip
that describes all errors prior to import. These rows are not imported.

All correct rows are highlighted by the + icon before they are imported, regardless
of any potentially faul  ty rows.
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The CSV file must be encoded as UTF -8 so language -specific letters (A,

access to security

B, ¢,

a , |tc,) are displayed correctly. The process to create a CSV file in UTF -8

format is explained in detail further down.

Creating a CSV file in UTF -8 format

The following description refers to Windows 7E using Microsoft Excel

that are already available in Windows 7E. The process to cr edfomatCSV

is similar for other Windows versions or operating systems. Required steps:

>

>

An Excel file featuring the data of persons you would like to import is assumed as
the initial basis for this description.

Make sure that the seventh column (Telephone number) has been formatted as text
in the Excel sheet. If this column were formatted as d
as "+" and "0" (zero) would be lost during the conversion. However, spaces within
the telephone number are permitted as they boost the legibility in the AirKey online
administration.

igits, leading charac ters, such

Use the Excel search function to verify the sheet does not contain the following

characters:
1 " (double, straight quotation marks)

91 ; (semicolon = separator in the CSV file for importing to AirKey online
administration)

Excel is unable to directly save the data in UTF -8 format. Consequently, itis
to initially save it in Unicode format.

possible

For this purpose, open the File -> Save as menu item in Excel (or press the F12

key).
Enter the desired file name in the following "Save as" dialogue window -
Inthe Filetype - drop-down menu select Unicode Text (*.txt) format.
Click Save ®.
o File name: Persons to import.bd -
eSave as type: [UmcodeText (".bt) v]
Authors: AKADEMIES / EVVA Wi... Tags: Add a tag Title: Add a title
= Hide Folders Tools - ’ Save ] ’ Cancel ]
Figure 32:Excel i Saveas i "Unicode Text (*.txt)"
Then confirm the subsequent Excel promp t referring to "Unicode Text" with
Microsoft Excel |E|

Persons to be imported. txt may contain features that are not compatible with Unicode Text. Do you want to keep the workbook in this format?

o

':0_' « To keep this format, which leaves out any incompatible features, dick Yes.

== wTo preserve the features, dick No. Then save a copy in the latest Excel format.
« To see what might be lost, dick Help.

[ Yes ] [ Mo ] [ Help ]

Figure 33:Excel i Save as "Unicode Text (*.txt)"

Yes.

E

auxi

fi
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> Open the file you created (*.txt) wusing a text ed
the Editor program.

> Tabisthe separator in the Unicode text file. All tabs must be replaced by semi colons
(;). For this purpose, initially highlight a tab between two fields and copy it.

"] Persons to be imported.txt - Notepad [=][@ =]

File Edit Format View Help

1) First name (mandatory) 2) Last name (mandatory) ) Identifier 4) Gender (M / F)

7) Telephone number (to be formated as text) 8) street 9) postcode 10) city 11) country
smallest record en-uKk

Anna Otker AD F 1997-12-20 emaill@gmx.com +43 664 123 456 789 schone Strafe 1 1130 wWien
Jan Cesky 1.¢. M 1964-05-17 +420111222333444 PFipotoéni 1337 101 00 Prag CZE
pany pevito DD en-uk  Person 1

Dany devito DD en-uk  Person 2!

5) Date of birth (3333-MM-TT)
12) Language for correspondence 13) Comment

AUT de-DE

€5-CZ "special characters: ¢, 1,

©6) E-mail address -

"special characters: ¢, 0,
[

Fy

Figure 34: Text file in "Editor"

> Bestatigen Sie die anschlieBende Excel -Frage

> |n Editor
window.

open the Edit -> Replace

9 Insert the tab character from the clipboard in the
not possible to  directly input it here.

1 highlight a tab and copy it to clipboard

Search

bez¢glich

1 Enter a semicolon (;) in the Replace field.

1 Click Replaceall -.
Replace @
Frdwhet: |
Repace wth:

o Replace All
Cancel

I Mot cose
Figure 35:"Editor" i replacing all tabs with semicolons

> Close the "Replace" dialogue window and in Editor

item to open the "Save as" dialogue window.

AUda.code

Text

menu item to open the "Replace" dialogue

field because it is

openthe Edit -> Saveas menu

1 Manually change the file suffix from .txt to .csv in the File name - field. It
will be more complicated to rename the file suffix at a later stage!
1 Inthedrop -down listselect Encoding - and UTF-8 format.
1 Click Save ®.
File name: Personsto beimported.cwo -
Save as type: [Ta‘t Documents (*.bd) v]
= Hide Folders e Encoding: [UTF—S v] l Save ’ Cancel l

Figure 36:"Editor" 1 Save as i Manually enter .csv file suffix and select UTF

-8 encoding
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>

This process creates a CSV file that can

nistration.

You can directly open the CSV file using Excel. Do NOT make any changes to

the CSV file in Excel as the file wo

uld then not be saved in UTF

then be imported to AirKey online admi

-8 format!

For instance, open the file in the Editor and subsequently save it there after
having carried out any minor, retrospective changes to the personal data.

If there are comprehensive changes to the personal data we recommend to

make these in the original Exce

create a CSV file in UTF -8 format.

| file before repeating the entire process to

access to security

Importing the CSV file to the AirKey online administration in UTF - 8 format
Proceed as follows to import a CSV file with personal data:
> Onthe Home screen, selectthe Persons tile.
> Alternatively select  Media & persons - > Persons in the main menu.
> Click Import = on the right.
AirKey - e
# vome B ACCesscONTROLSYSTEM B MEDIAGPERSONS [ PROTOCOLS [ ADMINSTRAIORS (@) HEW®
Persons o L% wnport } Expa
Figure 37: Importing persons
> Click Selec tfile.
> Select the corresponding CSV file you would like to import.
> You are provided with an overview of the persons to import.
> Click Start import .
2 persons available to import

Row First name Last name = | Identifier Date of birth E-mail address ;:I;ﬂc;ne

3 Max Mustermann 190 1371172001 jsmith@gmail.... 43123456 ]

2 John Smith m 1211172001 J-smithggmail 43123456 v

4 John Smith 13 141172001 j smilh@gmail, 43123456 v

5 John Smith 114 15/11/2001 j.smithgmail.com 43123456 x

Show 110 4 of 4 entries, 10+ Entries per page N 41 p The following errors occurred with the data set:
3 Gender must be either M or F.
» The input e-mail address is invalid.
*” cancel 23 o | & start impor
Figure 38: Importing persons

> Areport is output listing the number of successfully imported persons and faulty

rows.
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> Click Close .

Import persons

2 persons have been imported successfully.

Row3: Person already available.
Rows5: Gender must be either M or .
Row5: The input e-mail address is invalid.

| & Export result 33 + Close

Figure 39: Importing persons 1 result

> The AirKey online administration automatically forwards you to the overview list of
persons.

> Assign the desired access authorisations to the corresponding persons individually
using the familiar process described in Assigning media to persons . Consequently,
identical access authorisations can be quickly and eas ily duplicated. Please refer
to Duplicating media _ for more information.

4.8 Creating smartphones

You must create or add smartphones to your access control system  before you can manage
them as part of your access control s ystem .

> Onthe Home screen, in the grey bar of the Media and persons section, click
Add -> Add medium

> Alternatively, on the Home screen, selectthe  Smartphones -> Add medium
tile.

> You can also select Media & persons and Add medium inthe left -hand
navigation bar.

Create new medium

Please select the type of the new medium: |

Smartphone Card

Creates a new medium of type "smartphone”.

* cancel 12 o = Continue

Figure 40: New smartphone or card media

> Select Smartphone  as the new medium and click Continue -

> Enter unique information (e.g. smartphone type) in the "Designation” field.
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> Enterthe smartphone & telephone number (starting with "+" and the two digits of
the country calling code).

> Click Add medium -.

Media type  Smartphone

Designation

Designation...

* Telephone number

+43 664 123

4 Back 22 o M Add medium

An error message will appear if the telephone number is invalid or the

Figure 41: Creating new media

telephone number has already been created.

Now you are in the details section of this smartphones.

> Click Create registration code

- if you have not yet created a registration code.

A HOME

4‘.‘

4312312345

EVVA) Airkey

B ACCEsSCONTROLSYSTEM QR MEDIAGPERSONS B PROTOCOLS

Edit medium
Mushonsations | Detals | Protocol | € Relood view
Assign the medium to 3 person to create suthorisations.

Medium

+43123123456456

s [} Unknown

Appvession -

Regatration

Jo ADMINISTRATORS @ HELP

Progress Create a

Regstration code  Create registration a.weo

for this for the medium.

Manterance mode Actreate special authorisation *maintenance mode” for this smartphone
You have to assign the medium to 2 person in order 10 activate maintenance authorisation.

Medium can activate office mode

" Show protocol data in the Airkey app.

The Registration section shows a valid registration code and its expiry date. You can also
send it by text message (SMS). For this purpose, you must merely click the corresponding
link. Then the exact date and time appears when

message (SMS).

Figure 42: Creating registration codes

access to security

the registration code was sent by text

39



AirKey system manual version 2.5.0 | 25/10/2019 | Subject to misprints and technical changes

iegistration

Progress [ Registration started
Registration code 3022 2882 6171
(valid until: 02/07/2017 07:20) Create new registration code
You can send a registration code by SMS message or hand it over personally (e.g. by telephone or e-mail).

Send by SM5 message now

Figure 43: Registration code

access to security

Specify the following parameters in the Settings  section in the smartphone & details

section:

Settings

Maintenance authorisation [ This smartphone can be used to perform additional maintenance operations on AirkKey components
Office mode Medium can activate the manual office mode
Show event log data Show event log data in the AirKey app
Release duration @ Normal release duration
Z) Extended release duration
PIN code of the Airkey app ~ No PIN code set

Update the Airkey app data  inactive

Figure 44: Editing media 1 settings

> Special authorisation "Maintenance authorisation ": Maintenance
authorisation can exclusively be activated on smartphones that have already been

assigned to a person.  Smartphones with maintenance auth orisation are  granted to

unlock locking component s in factory state and add or delete media as well as
component s to access control system s. The maintenance authorisation

locking

additionally allows  updates of the locking component firmware and of the media

Keyring .

> Medium can activate office mode: select this option and the access medium

can set the automatic office mode _ status at the locking component . However, the

medium must  have been assigned a valid authorisation for the corresponding
locking component  s.

> Showing event log data/ entries in the AirKey app: this option shows
persons their own access events and any other event log data relevant to the
media in the AirKey app.

> Release duration: Specifies how long the  locking component  is unlocked when

using this particular smartphone. The length of the normal or enhanced release
duration is specified in the locking component s (from 1 -250 seconds).

> PIN code : Shows the status of wh  ether PIN code protection is on or off in the
AirKey app of this particular smartphone. If it is active and the person has
forgotten their PIN code, you can reset it here.

> Update the AirKey app data: Specifies the status whether or not the Airkey app

data of this smartphone is automatically updated after each locking process.
Details on how to activate this function can be found in the General chapter.
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4.9 Registering  smartphones

You can register smartphones once you have created them in the access control system
and you know the registration code.

> Start the AirKey app on your smartphone.

> Accept the license agreement and any queries about access to certain services of
the smartphone.

> If the smartphone has not been connected to an access control system, the
dialogue to enter the registration code appears automatically.

For iOS smartphones, tap Registration code already received to skip
entering the phone number and go to entering the registration code.

bl A1LTE 07:24 34%8 )

Add access control system

Please enter your telephone number.

Your telephene number

Cancel Continue

Registration code already received

Figure 45: Airkey app i adding access control systems iOS

> Enter the registration code you received from the access control system
administrator.

Add access control system

Please enter the registration code
you received from the access
control system administrator:

CANCEL  REGISTER

Figure 46: AirkKey app i adding access control systems

> Click Register to confirm.
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You can also register a single smartphone in several access control system  s.
Select Settings -> Add access control system in the AirKey app main
menu to re -open the registration dialogue. Further informations you can find

in Using smartphones in several systems

An error message appears if the registration code is invalid or has ex pired.
In this event, please contact the access control system  administrator from
whom you received the registration code.

If users delete the AirKey app or app data, there is the option to once again assign
authorisations that had already been granted t o the smartphone without using additional
credits. However, this exclusively applies to the same device and your access control
system . This option does not apply to a different device (in the event of replacements).

> Onthe Home screen selectthe Smartphones  tile.

> You can also select Media & persons - > Media in (the upper left corner of) the
header

> Select the affected smartphone from the overview list.

> Click Create new registration code and send the registration code to the
person wanting to  register a smartphone tothe  access control system

> Enter the registration code in the AirKey app and the smartphone is registered to
the access control system

If your smartphone had previously b een registered to an access control
system and it had not been correctly removed from this system when the app
data was deleted and you then register your smartphone to a different access

control system , a message appears indicating the smartphone had already
been registeredtoan  access control system . You can register the smartphone
as usual if you ignore the message. The smartphone is created as a new
medium and any previous data is rendered unusable.

EVVA recommends assigning a PIN code. It serves as an additional level of
security. You can  subsequently activate or deactivate the PIN protection.
Pleaserefertothe Activating PIN codes _ section for more detaile  d information.

49.1 "Send a Key" function

To all persons owning a smartphone you can also send keys using the "Send a Key"
function. This function is useful to administrators and saves smartphone owners from
manually entering the registration code for a new access control system

> Clickthe "SendaKey " button.
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EVB Airke ; -
T v~
or W e =]

Figure 47: Send a key:

Enter a person & name, code, etc. in the search field. If you are aware of the fact
the user has not yet been created, selec t Create ne w.

r

"Send a Key"

With "Send a Key” you can create new smartphones, register them, and then immediately send them
authorisations.

Or you use the function to send authorisations to existing smartphones.

Enter the following in the search bar to start the function:

Person, Identifier, Designation , Telephone number, Media ID

Q =k Create new

x Cancel

Figure 48: "Send aKey" i search field

Click Continue once you have completed all mandatory fields. A text message is
immediately sent to the corresponding user containing a link to the Airkey app to
register for an access contr ol system.

create a new person with smartphane.
*Firstname | Firstname
*lastname | Lastname
Identifier Identifier
*Telephone number | Telephone number
Language for comespondence  English =
If you have not yet registered the the reg sent to the

code is
input telephone number by SMS message. You can assign authorisations and immediately send
them as part of the next step.

4= Back

Figure 49: "Send aKey" 1 creating persons

Depending on the smartphone & network availability it may take some time
until it receives the  Registration code text message (SMS).
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Airkey
https-/fuat aickey.evva com/sak hmite.

Friday, 26 May + 1235

Manday 23 May - 1614

OPEN WITH

A @ ¢

Airkey Samsung Infernet

Figure 50: Text message (SMS) with link i shown here on a Samsung Galaxy S7 Edge

>  After opening the link from the SMS with AirKey, the registration is automatically
started and executed.

Registration successful

Your smartphone has been
successfully added to the access
control system.

To protect AirKey from unauthorized
use, you can additionally set a PIN
code in the AirKey security settings
(recommended). This PIN code must
then be entered before each access.

CLOSE

Figure 51: Registration successful

Proceed as follows if you have not yet installed the AirKey app on the
smartphone:

>

Click the link in the text message (SMS) and install the app on the
smartphone.

Start the AirKey app

On Android smartphones the registration is started and executed
automatically. On iOS smartphones, enter your phone number and
confirm with  Next .

access to security
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i A1LTE 09:22 57 %m )
Cancel Addaccess cont... Continue
Please enter your telephone number.

Your telephane number
+43123456789
Cancel Continue
aBc DEF
4 5 6
GHI JKL MHO
7 8 9
PaRS Tuv wxvz
+*H# 0 <)

Figure 52: Enter phone number iOS

> You will receive another SMS. Stay in the AirKey app and select the
eight -digit registration code that will be displayed above the
keyboard.
AirKey

Your registration code for Airkey

(3 minutes valid). Code: 80557339
Please enter the ¥ or 12-aigit registration
code you received from the administrator
of the access control system

rYDU( registration code

Cancel Register
Aus ,Nachrichten”
80557339

1 2 3
ABC DEF

4 5 6
GHI JKL MNO

7. 8 9
PaRs Tuv wxyz
0 &

Figure 53: Registration code iOS

If the eight -digit registration code is not displayed as a suggestion,
or you have closed the  AirKey app in the meantime, you must copy
the eight -digit registration code from the SMS and paste it within the

AirKey app.
> Finish the registration with Register
In the online administration you are taken to the Edit medium  authorisation view to create
the desired authorisations. Drag and drop the corresponding locking component  to which
you would like to grant the access authorisation to the desired access type (p ermanent
access, temporary access, periodic access, individual access) I see also Assigning

authorisations .
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(EVVA) AirKey
& @ - 28 moasrons 8
6 meiom
; mmmmmmm Py
" =
B Qs

3 M cotrance

Figure 54: Access types

4.10 Installing locking component S

4.10.1  AirKey cylinders , hybrid cylinders, lever cylinders and padlocks

Follow the assembly manual enclosed with the packaging during assembly of the AirKey
cylinder , hybrid cylinder, lever cylinder and padlock or the online assembly video clip at
https://www.evva.com/en/airkey/website/

Make sure both sides of a double -sided AirKey cylinder have been configured
within the access control system  to prevent locking users in or out.

4.10.2  AirKey wall readers

Please note t he assembly manual enclosed in the packaging to assemble the AirKey wall
reader. Our homepage additionally provides a drilling template or the assembly video at
https://www.evva.com/en/airkey/website/

indoors, in a secure area. Check the cabling on the wall reader and control

c One control unitis required per wall reader. The control unit must be installed
unit.

Locking components  are always supplied in factory state.

> Media in factory state can unlock locking component s in factory
t f s state.

> Smartphones with installed AirkKey app and enabled maintenance
authorisation can unlock locking component s in factory state

> Unlocking attempts a  re not recorded in factory state.

> Locking authorisations have only been assigned after having added
the locking component toa access control system
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> Observe the notes in the assembly manual during assembly. Open
the door and secure it against accidentall y slamming shut during
assembly and disassembly of the locking component  s.

411 Adding locking component S

Add locking component s to the access control system using smartphones featuring
maintenance authorisation or an optionally available coding station. Locking components
must be in factory state.

You must meet the following requirements to add locking component s using
your smartphone:

> The AirKey app has b een installed.
> An active Internet connection is available.

> The smartphone has been registered within the access control
system .

> The smartphone has been assigned to a person.

> The maintenance authorisation has been assigned to the
smartphone.

4.11.1  Adding locking component S using the smartphone

> Start the AirKey app.

> Establishing a connection using NFC (for Android smartphones): Tap the Connect
to component - icon.

> Establishing a connection using Bluetooth  (for Android smartphones): open the
context menu of the locking component in factory state which you would like to
add to the access control system (& and then select  Connect - .

> Establishing a connection using Bluetooth  (for iPhones ): swipe the "In factory

state" designation of the locking component  in factory state which you would like
to add to your access control system  towards the left and then select Connect ®.
= Bluetooth components 0@ = Bluetooth components @ = Bluetooth components

Bluetooth locking components within range

Bluetooth locking components within range

Bluetooth locking components within range —‘."

Y IQ "fa‘f:’t?‘ry“state

Connect Office mode
Searching for locking B Door2 OConnec( e

components

Office mode

° B Door2
T RS

Note the range Wake up the cylinder in
advance by touching

Figure 55: AirKey app i connecting to components (using NFC for Android smartphones/using Bluetooth for Android smartphones/using Bluetooth for
iPhones)
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>

>

>

access to security

Connect to component

N

0

Hold the smartphone to a locking
component (e.g. a cylinder) or an
identification medium (card or key
tag) to update it.

CANCEL

Figure 56: AirKey app 1 connecting to components

Hold the smartphone to the locking component  in factory state  or select the
corresponding locking component  from the displayed component list within range.
The smartphone establishes a connection to the locking component

Do not remove the smartphone from the locking component  while it is
establishing the connection.

Connect to component

O

Processing... Do not remove
smartphone from component.

CANCEL

Figure 57: AirKey app i connecting

Now you see information about the locking component

< Component details

@ Cylinder in factory state

4 Add component

Cylinder
NFC / Bluetooth

it | 000508E2C227AD98
Thumb turn firmware:
4.54
Electronics module
firmware: 4.54

Locking component Java
Card applet: 6.44

trol systerr None

nent 1§ Battery OK

Figure 58: Adding components

Tap Add component.

Enter a unique designation for the locking component
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Make sure both sides of a double -sided cylinder have been configured within
the access control system . Assign a clear designation to each of the sides on
cylinders with double -sided access. Create an area that features both sides
of the cylinder and assign an area authorisation to obtain the same
authorisation for both sides.

> Select the access control system  to which you would like to add the locking
component if the smartphone with active maintenance authorisation is registered
in several access control system s.

Add component

Add component Component ID: 000508E2C227AD98
DESIGNATION

Component ID: 0005DFOE1B14013E MR Eila

Main entrancd Additional information

Addiienslintormaten @ s e

details.
Save the current GPS coordinates as the
location in the component details.

Add to the following access control

system: Add 10 the following access control
system:

Test f. Eva Testf. Evva

CANCEL ADD
Cancel Add

Figure 59: AirkKey app i adding locking component s Android/iPhone

> Tap Add .
> Now once again hold the smartphone to the locking component  to complete the
process. Bluetooth connection will be established automatically.
The system checks the data and updates the locking component
In this process, do not remove the smartphone from the locking component
> A confirmation prompt completes the process. The locking component  is now

available for management in the AirkKey online administration.

Component was added

The component was added to
access control system "Test f.
Evva" for further configuration.

A temporary authorisation for the
component has been created.

The authorisation will expire in 4
hours. In order to be able to unlock
components after this period
please renew your authorisation.

CLOSE

Figure 60: AirkKey app 1 locking component added
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The locking component appearsinthe locking component s overview listin the AirKey online
administration. If the GPS coordinates - were determined when the locking component
was added, they are available in the locking component & section of the online
administration in the Details tab in the "Door" section.

Door

Door designation Main entrance
Additional information Additional information

Location 48.1?1515215.32958350

. Show in Google Maps

Figure 61: GPS coordinates inthe  locking component  details

Alternatively enter the address in the "Location" field where the locking component is

located.
The locking component  is now no longer in factory state. Media in fa ctory
state or smartphones in maintenance authorisation  are consequently no
longer authorised. The smartphone that added the locking component s
automatically authorised for a period of four hours. Please change the
corresponding authorisation or assign a dditional media with a valid
authorisation to continue to have access to this locking component

4.11.2  Adding locking component S using coding stations

Proceed as follows to add  locking component s using coding stations:
> Onthe Home screen, selectthe Cylinders or Wall readers tile.

> Click the Add locking component  button - .

> Alternatively, select  Access control system -> Add | ocking components in the
main menu.
AirKey o

& HOME B ACCESS CONTROL SYSTEM ‘l MEDIA & PERSONS a PROTOCOLS Ig ADMINISTRATORS e HELP

Locking components

Door designation, Additional information, Companent If Alcomponenttypes »  Al@  Onlyown(2) Onlyextemal (0) « Only current (1) §) Not current (1)

Door designation (additional information) ~ | Companent type Component ID Number of areas ;f:[ﬁ el Number of shares Logging

Door 2 #  Wollreader (000565F246DFI29A a own o Yes
Main Entrance #  Cylinder (000508E2C227AD38 2 Own o ‘es

Show 10 2 of 2 entries

oAud locking compenent [% expont
Figure 62: Adding locking component s
> Connect the coding station to the computer otherwise the system notice
appears. -
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Add locking component
1 4if\ Please select a coding station.

°

Component in factory Shared locking
state component

Please select the type of the new component:

e.

x Cancel

Figure 63: Adding locking component s/no coding station

> Select Component in factory state.
> Click Continue

> Enter the door designation in the following dialogue window and click Continue

Add locking component |

Details

Door designation
Door designation

Additional information

Additional information

* The ination of door i ion and itis f ion must be unique.

¥ cancel 12 =p Continue

Figure 64: Adding locking component s i assigning names

> Follow the on -screen instructions and place the locking component  on the coding
station.

Add locking component

Please place the locking component on the coding station.

4= Back 12

Figure 65: Adding locking component s

> A confirmation prompt appears and the locking component  is added to the access
control system
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Add locking component

Your new Cylinder has been added successfully.

v

22 K Close

Figure 66: Adding locking component s i confirmation

After having confirmed the prompt you are forwarded to the detailed locking component
view.

AirKey

A HOME £ ACCESS CONTROL SYSTEM A% MEDIA & PERSONS a PROTOCOLS Jis ADMINISTRATORS 0 HELP

Edit locking component
Details. Settings Authorised media (own) Authorised media (external)

Details

Componenttype  Cylinder
Model NFC
Component ID 0005DFOE1B14013E
Firmware version  Java Card applet 6.44, Thumb turn version 4.54, Electronics module version 4.54

Componentstatus [ Battery OK (status from 03/07/2017 09:06:33) (i; Time correct ‘& Current time zone i3 Blacklistup todate 5% Arez

Last update -
Door
Door designation Door designation
Additional information | Additional information
Location | sddress or GPS coordinates
Show in Google Maps
Areas

Area designation

Figure 67: Locking component  details

The locking component is now no longer in factory state. Media in factory

state or smartphones with maintenance authorisation are consequently no

longer authorised to unlock the locking component . Add a medium or
smartphone to the  access control system  and assign valid authori  sations to
said locking component s to continue to be able to unlock them.

The default time zone and data protection settings are automatically
configured for the added locking component according to the specified
settings. Refer to  Default values (for all recently added locking components )
for more information on these settings.
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Alternatively, you can also just place a locking component  in f actory state on
the coding station. An information window appears in the bottom right,
enabling you to also add the locking component  tothe access control system
using the Add component to my access control system link.

Component in factory state

The component does not yet belong to a access control

system.
+ Add component to my access control system

Figure 68: Adding components to my access control system

412 Adding cards, key tags, combi keys  and wristbands
using a smartphone

Access media in factory state are added to access control system s using smartphones with
maintenance authorisatio  n or an optionally available coding station.

> Start the AirKey app.

When using smartphones to add combi keys to the access control system  you
must hold the combi key side featuring the RFID icon to the smartphone.
Most models require the combi key to be held directly on the smartphone.

This action is available using an Android smartphone that is compatible with
NFC. Please refer to the  Encoding media  section for details on adding media
using Bluetooth with an Android smartphone or an iPhone.

> Tapthe Connectto component - icon.

=  Bluetooth components 0@

Bluetooth locking components within range

Searching for locking
components

vl S

Note the range Wake up the cylinder in
advance by touching

Figure 69: AirKey app i connecting to components

> Hold the smartphone to the medium in factory state.
A connection to the medium will be established.
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Connect to component

N

[

Hold the smartphone to a locking
component (e.g. a cylinder) or an
identification medium (card or key
tag) to update it.

CANCEL

Figure 70: AirKey app i connecting

> Do not remove the medium from the smartphone while it is establishing the
connection. Now you see information about the medium.

€ Medium details

@ Card in factory state

+ Add

Media type Medium
Media ID 0005CDE9860F272A
Keyring version 6.18

Status Authorisations,
office mode and
release duration are
up to date,

 Keyring version up
to date

155 control system  None

Figure 71: Medium details

> Tap Add .

> Enter a designation for the medium.

Add medium

Media ID: 0005CDE9860F272A

Back door

Add to the following access control
system:
Test f. Ewa

CANCEL Amq

Figure 72: Adding media 1 specifying designations

> Selectthe access control system  to which you would like to add the medium if the
smartphone has been registered in several access control system  s.

> Tap Add -.

> Now once again hold the smartphone to the medium to complete the process.
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>

4.13

access to security

A confirmation prompt completes the process. The medium is now available for

management in the Airkey online administration T and it must now be assigned to
a person.
This process is i dentical for cards, key tags, combi keys and wristbands . All

three elements are grouped in "Card".

Assigning persons to media

As part of the  continue step, you must assign the medium to a person within the Airkey
online administration to be able to assign authorisations. This is the only way to link
persons to access events.

>

>

>

>

Onthe Home screen, selectthe Smartphones or Cards tile.
Alternatively select  Media & persons -> Media inthe main menu.
Select the medium that has not been assigned to a person yet in the media list.
Continue tothe No person button clickthe + icon =

AirKey

& HOME £ ACCESS CONTROL SYSTEM &% MEDIA & PERSONS B PproTOCOLS J ADMINISTRATORS

Edit medium
. Authorisations | Details | Protocol | (% Reload view
No person Assign the medium to a person to create authorisations.
+ Medium
Media type ~ Card
p > typs
¥\ (1, MedialD  000SCDE9BEOF272A
Designation  Back door
Back door
Status  +# Upto date
T Lastupdate  03/07/2017 09:27:56

Keyring version ~ 6.18

Figure 73: Assigning persons

Select the person from the persons list you would like to assign this medium to.

Select a person to be assigned to medium “Back door (0005CDEIBE0F2724)"
Firstname, Last name, Identifier, E-mail adc’ =k Create person
e First name Last name identifier E-mail address
Horst Backer - - =
Florian D
Adrian H
Peter Huber
Anna Maller -
Maria Maller 123456 3
Sabine Ribits
Hanspeter Seiss Airkey
Jane Smith - -
John Smith m j smith@gmail.com
John Smith 113 j smith@gmail.com
Max Mustermann 31 m.mustermann@gmail com
Max Mustermann 30 m.mustermanng@gmail.com

Figure 74: Assigning persons to media

If a certain user has not been created yet, use the Create person button to open
a se cond dialogue window, "Assign medium to person "
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> Select Assign person = to confirm you would like to assign the selected person
to the medium.

Medium

Media type
Gard

Media ID
000SCDEIB6O0F272A

Designation
Back door

Details

Ferson
Jane smith

Identifier

E-mail

4= Back m °*‘ Assign person

Figure 75: Confirming persons

> Please referto Assigning authorisations for more information.

Alternatively, you can also assign media to persons using the medium. Please
refertothe Assigning media to persons section for more detailed information.

4.14 Assigning authorisations

Please note that you can only assig n authorisations once a medium has been
assigned to a person.

> Select Media & persons -> Media inthe main menu.
> Select the desired medium from the overview list.

> If the medium has been assigned to a person, an overview of authorisations for
this medium a ppears.

> As soon as you drag and drop the corresponding locking component  to the grey
area, available access types appear in the four areas with dotted edges.

Figure 76: Assigning authorisations
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> Drag and drop the

access to security

selected door/selected area to the corresponding field to select

the desired access type.

Four access types are available:

>

>

4141

Permanent access indicates access is grante

Permanent access
Periodic access
Temporary access

Individual access

Permanent access

restrict the authorisation.

d at any time. Specify a start and end date to

©7) Permanent access

(] Periodic access

Create new authorisation with
access by calendar

Enables access within a certain
period (time) on a certain day.

Create new authorisation with Create new authorisation with
permanent access periodic access
Enables constant access during a Enables repeated accesses on
rartain narind (date) weekdays during a certain period
é Main Entrance (date).
‘ 000508E2C227AD98 [
Temporary access ] Individual access

Create new authorisation with
combined access types

Enables any combination of several
access types.

Figure 77: Assigning permanent access authorisations

> Specify the period of permanent access.

You can choose between unrestricted, permanent

with a specified start and end date.

> Click Save .

E Main Entrance
000508E2C227ADSE

o0 Permanent access

@ always applicable

© from

M cancel

to

access or permanent access

New authorisation — Permanent access

EISave

Figure 78: Assigning permanent access authorisations
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acoess to security

4.14.2 Periodic access

Assign periodic access for recurring access at certain times. For instance, recu rring access
events could be a series of weekly appointments.

@2 Permanent access @ Periodic access
Create new authorisation with Create new authorisation with
permanent access periodic access
Enables constant access during a Enables repeated accesses on
certain period (date). s Aurinn  eartain narind

(date). 2. Main Entrance
DD0S08E2C227AD38

Temporary access lﬁ Individual access
Create new authorisation with Create new authorisation with
access by calendar combined access types
Enables access within a certain Enables any combination of several
period (time) on a certain day. access types.

Figure 79: Assigning periodic access

The system shows a weekly calendar allowing you to define up to four periods for each day
of the week.

> Specify the period of periodic access.

New autherisation — Periodic access I

a Main Entrance
(000S08E2C227AD98

(B Periodic access

from 0300712017 [ [GE™ [l
@ unlimited

r#Add periodic access

Wednesday Thursday Friday Saturday Sunday

ot valid for thy “Main Entrance” and its defined public holidays.

¥ cancel [ save

Figure 80: Assigning periodic access

> Directly highlight the period in the calendar or click Add periodic access
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all Monday ] Tuesday
] Saturday ] Sunday
from 0700 to | 1700
[ all day
x Cancel

] Wednesday [ Thursday ] Friday

[ save

> Enter the desired period and click

> Alsoclick Save inthe "New authorisation

4.14.3

Figure 81: Adding periodic access

Temporary access

Save .

T Periodic access" window.

Assign single access authorisations, if access must be restricted to a certain day and a

certain period.

@2 Permanent access

Create new authorisation with
permanent access

Enables constant access during a
«certain period (date).

@ Periodic access
Create new authorisation with
periodic access

Enables repeated accesses on
weekdays during a certain period

(date).

Temporary access

Create new authorisation with
access by calendar

Enables access within a certain
nerind time) on a rerain day.
Main Entrance

@ Individual access

Create new authorisation with
combined access types

Enables any combination of several

access types.

000508E2C227AD98 J

> Enter the desired period and click

Figure 82: Assigning temporary access authorisations

Save .

New authorisation — Temporary access

from | 10:00

* cancel

a Main Entrance
000508E2227AD98

Temporaryaocess
on 030712017 [f] [ allday

to | 13:00

™ save

Figure 83: Assigning temporary access authorisations
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4.14.4 Individual access

Assign individual access authorisations if you require a combination of permanent access,
single access and periodic access.

©% Permanent access (C] Periodic access ‘
Create new authorisation with Create new authorisation with I
permanent access periodic access |
Enables constant access during a Enables repeated accesses on
certain period (date). weekdays during a certain period

(date)

Temporary access %é? Individual access
Create new authorisation with Create new authorisation with
access by calendar combined access types
Enables access within a certain Enables any combination of several |
period (time) on a certain day. access types. |

o i | L% Main Entrance
i 000508E2C227AD98

Figure 84: Assigning individual access

> The "New authorisation T Individual access" dialogue window shows any individual
access authorisations you have already assigned.

> Click an entry in a row to change the authorisation.
> Alternatively click  Add access - for a new entry.

New authorisation — Individual access

E Main Entrance
000508E2C227ADIB

r‘igg’“llndmdual access

Access type ~ | Validity
Mo data found

;¥ Add access (8 still possible] o

K cancel

Figure 85: New authorisation i individual access

Select permanent access , periodic access or temporary access and define
the specifications in each case. The parameters correspond to the access
authorisations that have been described above.

Permanent access Periodic access Temporary access
Figure 86: New authorisation i individual access

> Click Save once you have configured all authorisations for individual access.

> Permanent access and periodic access periods must not overlap.

> |tis possible to define a maximum of one individual access period
per day.
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> [f individual access and periodic access periods overlap, both access
types are valid.

> You can configure a maximum of eight individual authorisations.

4.15 Creating authorisations

After having created the access authorisations for a medium, you must complete the
process with Create authorisation and update the corresponding medium.

Changing an existing authorisation or creating new authorisations
changes the icon of the corresponding medium. You can now create
the medium, providing you h ave sufficient credit.

Create authorisation

@ 1 changed authorisation can be created. = Back

Figure 87: Issuing
authorisations
Figure 88: Creating changed authorisations

> Click the row highlighted in yellow at the top edge of the online administration or
the - icon of the medium to create authorisations

A corresponding message appears if you do not have sufficient credit at

this point in the process. You can immediately top -up your credit using a
link in this message. Topping up your credit using this message will
automatically create the authorisation and deduct one KeyCredit from
your account.

> You will receive a corresponding message indicating deduction from your quantity -
based credit as a result of creating the medium.

Do you want to create the changed authorisations to transfer them to the medium (card, key
tag)?

‘Waming: Check the authorisations for accuracy, as used KeyCredits cannot be reimbursed.

$ Your current credit is 86 KeyCredit(s).
1 credit will be deducted from your credit.

R cancel 13 S Create medium

Figure 89: Creating media

> Click Create medium to confirm  the process .

You must now update m edia, such as cards, key tags, combi keys or
wristbands using a smartphone or coding station for the authorisations to be
activated on the medium. Authorisations to smartphones are sent by push

messages (notifications)
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In the last chapter you learned to set up the access control system  correctly. The proce  sses
described herein illustrate the first steps and enable management of your access control
system . Please refer to the following sections for a more detailed description of individual

AirKey online administration functions and the AirkKey app.
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5 AirkKey onl  ine administration

5.1 AirKey login

The login is required to configure or manage the AirKey locking system. In the AirKey
online administration settings, a t wo -factor authentication can be optionally activated for
the login. Activation is described in the chap ter Access control system settings

Activate t wo-factor authentication to increase the security of your AirKey
locking system.

Failed login attempts are displayed on the start page and logged in the system
protocol . The display on the start page only appears if there has been at least one
failed login attempt since the last successful login.

AirKey

& HOME B ACCESS CONTROL SYSTEM A% MEDIA & PERSONS Q] EVENT LOGS Jis ADMINISTRATORS

Home
Failed login attempts since 26/04/2019 15:43:38 (with the current user): 1 a System event log
Figure 90: Failed login attempts
5.1.1 AirKey | ogin withoutt wo -factor authentication
> Open the following page in your browser: https://airkey.evva.com

The AirKey online administration login page opens.

> Enter the user ID you received in the "EVVA AirKey registration” e-mail .
> Enter your personal AirKey password and confirm with Login .
Once you have logged on, the system opens the Home screen. It provides an overview of

your AirKey a ccess control system

access to security
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5.1.2

>

>

(EVVA) AirKey s g T | 4 e .

fwouE | B oo At vewsresows [ Moo o AMmSTADE @) HEP

Home

[ER— i [ v

e _ Prr—— -8
Figure 91: AirKey online administration i home
AirKey login with t wo -factor authentication
Open the following page in your browser: https://airkey.evva.com

The AirKey online  administration login page opens.
Enter the user ID you received in the "EVVA AirKey registration” e-mail .
Enter your personal AirKey password and confirm with Login .

If no phone number has been verified for the administrator, a prompt appears to
enter a ph one number for verification.

Enter the phone number of the smartphone to be used for two -factor

access to securlty

authentication (starting with + for the country code) and confirm with Send SMS

code .

Becess to security
AirKey | Login
Two factor authentication is activated for this access control system.

In order to be able to log in, your telephone number must be verified. An
SMS5 code for logging in will be sent to this number.
*Your mobile phone number +43123456789|

Send SMS code Back

@ AirKey support Legal notice AirKey registration

Figure 92: Verify mobile phone number on login

An SMS with an SMS code is sent to the entered telephone number.

Enter this SMS code in the dialog within the online administration and confirm
with Login
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AirKey | Login

Enter the received SMS code.
SMS code sent to +43123456789

*SMS code  [kidsT]

Log in Back

@ AirKey support Legal notice AirKey registration

Figure 93: Enter SMS code for login

access to security

> The telephone number is now verified for t wo -factor authentication and the start

page of your AirKey locking system is displayed.

If the phone number has already been verified, it does not need to be re -
entered after entering the user ID and password. In this case, an SMS code

is immediately sent to the verified phone number.

The SMS code is valid for 5 minutes. Ifthe 5 minutes are exceeded, the login

process must be repeated.

Without access to the verified telephone number no login t o the AirKey online
administration can take place. If you want to change the phone number, you

have to change the phone number in the details of the administrator (see

Editing administrators ) However, this require s the currently verified phone

number. If the telephone number is no longer available, please contact

support .

5.1.3 Have you forgotten your password?

You can individually reset your password should it be unavailable. Clic
password ? =

AirKey | Login

Language: English -

User ID: User ID

Password: | Password

Log in o Forgot your password?

@ AirKey Support Legal natice AirKey registration

Figure 94: AirKey online administration login page

EVVA

k Forgot your
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> Enter your user name and the date of birth you entered upon registration in the
"Forgot your passoword  ?" dialogue window and click Reset password

Forgot your password?

Enter your AirKey user ID and your date of birth if you have forgotten
your password.

You will receive an e-mail with a link to reset the password.

*User ID User ID
* Date of birth DD/NMMAYYYYER
% cancel © Reset password

Figure 95: Forgot your password ?

> |Ift wo-factor authentication is activated, you will receive an SMS code to your
verified smartphone, which must be entered in the following dialog and confirmed
with Reset password . (This step does not apply if two -factor authentication is
not activated or the phone nu mber is not yet verified)

| Forgot your password? |

Enter the SM5 code.

You will receive an e-mail with a link to reset the password.

*SMS code SMS code

¥ cancel © Reset password

Figure 96: SMS code reset password

The SMS code is valid for 5 minutes. If the 5 minutes are exceeded, the
process must be repeated.

Without access to the verified phone number, the process cannot be
completed. If the telephone number is no longer available, please contact

EVVA support .

You will receive an automated e-mail from EVVA AirKey with the following subject line:
"EVVA AirKey online administration T password reset".

> Openthe e-mail from EVVA AirKey.

> Inthe e-mail, click the link to reset your password. The "Reset password" website
opens.

> Enter your new password and re -enter your new  password to confirm the process.
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> Click Save .

Reset password

Please enter your new AirKey password

The password must contain at keast a digit [0-9], an uppercase letter [A-Z) and a lowercase letter [a-z). Country specific letters (8, B, ¢, , £, etc) are treated as special characters and are only possible in addition to the 3 specified criteria.

*Password ~ eessssss

* Repeat password Repeat password

& Save
@ AirKey Support
Figure 97: Resetting the AirKey password
The AirKey online administration login page opens.
> Perform the login as described in AirKey login without two  -factor authentication or

AirKey login with two _ -factor authentication , with the new password.

If your input is correct, the AirKey online administration Home screen opens. The top right
shows the name of the user that has logged in.

If required, you can also change your password in the AirKey online
administration. For this purpose, click the administrator name in the right -
hand AirKey online administrat ion header and use the Change password
function .

AirKey

A& HOME H ACCESS CONTROL SYSTEM ‘l MEDIA & PERSONS a PROTOCOLS Iq ADMINISTRATORS e HELP
My AirKey account

Details

UserID 13968155 Change password
Tide M -
*Firstname | John
*lastname | Smith
* E-mail address
*Date of birth | 2410911976  [31]
Note: You require the date of birth for the "Reset password” function.
Telephone number | Telephone number
street | Street

Postcode Postcode

city | Cit
Country  Please select -
Contact information
* Language for corespondence  English -
E-mail notifications | would like to reqularly receive maintenance tasks from my access control system by e-mail
Never -

[ 1 would like to receive information about Airkey online administration updates and maintenance windows

I would like to receive important notifications from EVVA (recommended).

Figure 98: My AirKey account
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5.2 AirKey logout

Click Log off = to quit the AirKey online administration.

AirKe: o s oy gy v ) seuas o] oot
EvD y o

# HOME [ ACCESS CONTROL SYSTEM At meowsrersons B Proocols Jo ADMINISTRATORS ) HELP

Figure 99: Logging off

Despite having integrated an automatic logout feature after 30 minutes we
highly recommend administrators always log out after having completed

any due tasks in the AirKey online administration using the Log off button.

5.3 Administrators

Administrators have = comprehensive rights to manage the entire access control system
There must be a minimum of one administrator per client and access control
system .

Please refer to the  Administrators = main menu for the administrator management

functions .

AirKey Credit thnSmitr\'

) HOME [} ACCESSCONTROLSYSTEM L& MEDIAGPERSONS  [§) PROTOCOLS B ADMINISTRATORS () HELP

Home Administrators

> Create administrator manage nt for your AirKey access control
Media & persons. yste
Support logins _
v o E ;
C ' W 1
g

117 Persons 6 Smartphones 2 Cards *Send aKey" 1 Gylinder 1 Wall reader

Figure 100: Administrators main menu

5.3.1 Creating administrators

Administrators can exclusively be created by other administrators.
> |n the main menu select Administrators -> Create administrator.
> Complete the fields in the form. Fields highlighted by * are mandatory fields.

> In the "Contact information" field, you can also specify whether the administrator
should receive e -mail notifications about certain events, such as open

maintenance tasks, upcoming maintenance windows or other important
information. E -mail notifications are sent in the selected language for
correspondence.
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‘Contact information

* Language for correspondence English -
E-mail notifications | would like to regularly receive maintenance tasks from my access control system by e-mail.
Daily (8:00) :
Never mation about AirKey online inistration updates and mai e windows.
Hourly

frtant notifications from EVWA (recommended).

Weekly (Monday 8:00)

Remarks Montthly (1st day 8:00)

Figure 101: Contact information

> Click Save -.

(EVVA) AirKey e el il A

A HOME @ ACESCONTROLSSTEM AN MEDAGAERSONS [ PROTOCOIS  J ADMINSTRAIORS @) HeLP
Create administrator - ack

)
— °

e Pieasesded <

oty Fieasessied

ks by

c] et

[ 1 moukd e o receive vt obicators borm EYVA frecorsmencded)

Remarts

Figure 102 : Creating administrators

Check the e-mail address to which the activation link is sent before you save.

> Click Create administrator to confirm the security prompt and complete the

process.

Do you really want to create the administrator "Helen Miller"?
The administrator will shortly receive a confirmation by e-mail

Please check your e-mail address and correct it, if necessary.

¥ cancel ™ create administrator

Figure 103 : Creating administrators

The system reports "Administrator saved successfully" once you have created
an administrator.

Now the administrator you created receives an e-mail from EVVA AirKey with an activation
link.
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The data is deleted and the activati on link is rendered invalid if it is not

activated within 48 hours.

The administrator you created must complete registration as described below:

> Openthe e-mail with the subject line "EVVA AirKey registration".

> Click the activation link. The "Welcome to AirKey" website opens.
> Enter your personal password, re -enter the password and specify your date of
birth.

> Click Save .

This completes the process to create administrators. The system then opens the
online administration __ login page for administrators to log in.

5.3.2 Editing administrators

You can retrospectively change administrators 0 details, such as last name(s),
address, telephone number or contact inf ormation.

You are unable to change the user name.

> |n the main menu select Administrators -> Administrators
The system shows a list of all valid administrators.

Search for administrators, sort columns and restrict the number of entries shown per page
in the list on screen as well as export the list to a CSV file.

> Click the administrator whose details you would like to change.
> Change the desired data.

> Click Save -.

AirKey

e @ a w At wonsrows B ool b AMNSROOR @ KL

Edit administrator b Odeton

Figure 104 : Editing administrators

e-mail
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5.3.3 Deleting administrators

Exclusively administrators can delete other administrators.

> In the main menu click Administrators - > Administrators

> Click the corresponding row in the table to select the administrator you would like
to delete. The "Edit administrator" page opens.

> Click Delete -.

(EVVA) Airkey

A% wOwaron [ MOS0 b ADMINSTRAY o @ e

Figure 105 : Deleting administrators

> Click Delete administrator to confirm the security prompt.

Delete administrator

Do you really want to delete the administrator "John Smith™?

This process cannot be undone.

o cancel

@ Delete administrator

Figure 106 : Deleting administrators

The system reports "Administrator deleted successfully® once you have
deleted an administrator. Deleted administrators no longer appear on the
administrator list and they are consequently no longer able to log on to the
AirKey online administration.

54 Access control system se ttings

Configure basic settings in the AirKey online administration settings. These have been
described in the following sections.

> Onthe Home screen, clickthe Settings - tile.

> Alternatively click  Settings in the header.

access to security
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A HoMe B AccescommoLSSTEM B MEDWGPERSONS [ PROTOCOLS b ADMINSTRATORS @) HELP
Home
Mecia & prrsons - Accrss cantrol system o
D g (4 5:; m‘ m r
17 Persons & Senrphores 2 Carcs Son Koy 1 Cnder + Wall e 4 Areas
oo dessgration Component 10 Maimtcrance ks
Dowr 2 consesF24DFe2sA
- 1 Maintenance task
— W e o
= _ = 57 Publc heidays r—
= 7 bk bt 05 o = )
@ omirmiderio = s
© Teme zones:
350 Locking comperee pratocd 407 M protancd 06 Syt protocel Ortaut tne e i BV, UTE 5308 Topup et Sevtings
General Terms of Business (6T imprint [ ———r]

Figure 107 : Access control system  settings

54.1 General

In this tab, the following general settings can be activated for the entire locking system.

Bluetooth  settings of the AirKey app

Here you can configure for all smartphones in this locking system whether locking
components can be opened via Bluetooth from the lock screen or not. If this option is not
activated, the smartphone must be unlocked before each access.

Settings

General Default values Public holidays

Bluetooth settings of the AirKey app

Access from the lock screen [ This option allows the opening of locking components via Bluetooth from the lock screen without unlocking the smartphone.
If the option is not activated, the smartphone must be unlocked before each access.

Note: This option affects the AirKey app functions "Hands-free mode” and "Unlock from notifications”.

Figure 108 : General settings 1 Bluetooth settings of the AirKey app
This option affects the Ai rfKreeye anpopd ef iu nucn

from notificationshth.

Deactivate Access from the lock screen to improve the security level of
your AirKey system.

AirKey app settings

Here you can activate the option u pdate the AirKey app data after each un locking process.
If this option is activated, the AirKey app data (e.g. log entries or the battery status of

locking components) will be updated with a smartphone each time the unlocking process

is performed.

> Select the corresponding checkbox and confirm w ith Save .
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AirKey app settings

Update the AirKey appdata [ after each unlocking

Regardless of this, the AirKey app data on the smartphone is updated automatically every 12 hours.

Figure 109 : General settings 1 AirKey app settings

The functionality is then sent by push notification to all smartphones in this locking
system. At the latest after a manual actualisation of the AirKey app data of t he

smartphone (see chapter

Updating smartphones ), the functionality should be active on

the smartphone. You can find the current status - of the smartphone for this function in
the AirKey online administration in the details of the smartphone.

Settings

Maintenance authorisation
Office mode
Show event log data

Release duration

PIN code of the Airkey app
Update the AirKey app data

[T This smartphone can be used to perform additional maintenance operations on Airkey components
Medium can activate the manual office mode
Show event log data in the Airkey app

@ Mormal release duration
) Extended release duration

No PIN code set

inactive o

Figure 110 Status udate the AirkKey app data with each unlocking process

000

12 hours.

Two -factor authentication

Activate this function to transfer access au dit trail entries to the online
administration almost in real time when using smartphones.

Updating the AirKey app data after a unlocking process only transfers the data
of the smartphone that performed the unlocking process. This update is not
displayed visually on the smartphone itself.

A stable internet connection (mobile data or WIFI) is required for this function,
since a further unlocking process can only be carried out after the AirKey app
data has been updated.

Regardless of the option update AirKey app data after each unlocking process,
an attempt is made to update the AirKey app data automatically every

(2FA)

> The t wo-factor authentication, or 2FA, is used as an additional security level when
logging in to the AirkKey online administration. In addition to the user ID and
password, an additional SMS code is requested as a second factor. If t wo -factor
authentication is activated in the settings, it is applied to all administrators of this
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locking system. To activate it, click the Activatet wo -factor authentication
button.
Two factor authentication (2FA)
Two factor authentication (2F4)  Deactivated
Activate two factor authentication
Figure 111: General settings i Two-factor athentication (2FA)
> Enter the mobile phone number to be used for t wo -factor authentication for the

currently logged on administrator and click Send SMS code .

Activate two factor authentication

To aktivate the two factor authentication, your phone number must be verified.

An 5MS code will be sent to this number.

Your mobile phone number

+431224567829)
¥ cancel & send SMs code
Figure 112 : Verify mobile phone number settings
> An SMS code is sent to the previously specified t elephone number. This SMS code

must be entered in the dialog within the online administration and confirmed with

Save .

I Activate two factor authentication I

Enter the received SMS code to save the phone number and activate the two factor
authentication.

SMS code sent to 443123456789  Edit mobile phone number

ks

¥ cancel

™ save

Figure 113: Enter SMS code settings
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If a valid SMS code has been used, two -factor authentication is activated for all
administrators of the locking system. The status in the settings changes accordingly.

The SMS code is valid for 5 minutes. If the 5 minutes are exceeded, the
process must be repeated.

From the time of  activation, a mobile phone is required for each login. Details
on the | ogin process with activated t wo -factor authentication can be found in
the chapter AirKey login with two  -factor authentication

To disable t wo-factor authentication, follow these steps:

> Click on Deactivatet wo -factor authentication

Two factor authentication (2FA)

Two factor authentication (2FA)  Activated

Deactivate two factor authentication

Figure 114: Deactivatet wo-factor authentication

> Confirm the prompt also with Deactivatet wo -factor authentication

Deactivate two factor authentication

This deactivates the two factor authentication for all administrators of this access control system.

x Cancel Deactivate two factor authentication

Figure 115: Deactivatet wo-factor authentication prompt

The function is deactivated again for all administrators of the locking system.

AirKey Cloud Interface (API)

The AirKey Cloud Interface is a REST interface (API) for third - party systems. The interface
allows certain functions of AirKey to be controlled via third - party software. Details about
the AirkKey Cloud Interface are described in the chapter AirKey Cloud Interface (API)
AirKey Cloud Interface (API) T test environment

The test environment gives you the opportunity to test the AirKey Cloud Interface (API) in

a protected environment with test data before activation. P lease refer to the chapter AirKey

Cloud Interface (API) for details.
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5.4.2 Default values (for all recently added locking component S)

These settings are activated automatically if you add a new locking component . We
recommend specifying default values prior to the first installation to make it easier to

manage systems for administrators. This applies particularly for larger access control
system s.

Time and calendar

Access control system s enable the managementof locking component s located in different
time zones. The "Europe/Vienna" time zone (UTC+01:00 in winter and UTC+02:00 in
summer), applicable in central Europe, has been set by default.

Airkey

A& HOME 3 ACCESS CONTROL SYSTEM A\ MEDIA & PERSONS a PROTOCOLS Jis ADMINISTRATORS o HELP

Settings

General | Specification values | Public holidays

Default values for all recently added locking components

Time and calendar

Time zone  Europefvienna v UTC+02:00

Public holiday calendar  [7] Apply public holiday calendar

Figure 116: Default values for new  locking component s

Simply clickthedrop  -down menu and select the correct time zone from the list if you would
like to change the time zone for the entire access control system

On the Home screen, click the Cylinders or Wall readers tile, select the
desired locking component and browse to the  Settings tab if you would like
to change the time zone of one locking component . The Time and calendar
section features a drop  -down list with the time zones.

The sun icon in the corresponding time zone section indicates whether
summer or winter time is currently active.

“ Yellow sun = Summer time

¥ Grey sun = Winter time

Tick the Apply public holiday calendar box and the public holidays saved and activated
in the Public holidays tab (see Public holidays section) will be applied to the new locking
component .
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Areas

M@ Ry Ovdy not cumen 23

Area dessgration - Area status
[ream— )
et )

Show 1102 of 2 entries

4 ssign 1o areas

Figure 117: Defaultvalues 1 areas

This section describes how to automatically assign new locking component s to areas you
have already created. Please refer to Creating areas _ for details on where and how to create
areas.
This feature is particularly useful for general or fire service keys that must always h ave
access authorisations to all components. It is also possible to once again revoke assigned
areas from the corresponding locking component  s.
Access

Access

Office mode  [J Allow manual office mode

Enables manual office mode with authorised media (smartphones, cards, key tags).

Automatic office mode  Please activate "Allow manual office mode™ if you would like to use the automatic office mode function.

Release duration B 10 s normal release duration
20 s extended release duration

Update after each unlocking  [] The locking component is updated each time it is unlocked with a smartphone via Bluetooth.

Regardless of this, the locking component is updated each time it is unlocked with a smartphone via Bluetooth, if at least 6 hours have passed since the last full update.

Figure 118: Defaultvalues i access

In this section you can grant manual office modes for all recently added locking
component s. Tick the Permit manual office mode box to open an additional tick box:
Permitting automatic office mode

Access

Office mode Allow manual office mode
Enables manual office mede with authorised media (smartphones, cards, key tags).

Automatic office mode (] Activate automatic office mode
Activates the automatic office mode and end times for the manual office mode, with which the locking p opens or doses ically.

Release duration : 10 s normal release duration
20 s extended release duration
Update after each unlocking The locking component is updated each time it is unlocked with a smartphone via Bluetooth.

Regardless of this, the locking component is updated each time it is unlocked with a smartphone via Bluetooth, if at least 6 hours have passed since the last full update.

Figure 119: Automatic office mode

Automatic office  mode permits the specification of periods and unlocking times when the
locking component  locks or unlocks automatically. For instance, specify that office mode
automatically ends each night at 5 pm in an office building. For AirKey cylinders this not
only means the door has been locked, but also that the cylinder has been disengaged. Use

an authorised medium to engage and subsequently manually unlock a cylinder to open the
door.
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You can also specify an end time for manual office mode in this dialogue window . This
makes sure that office mode is deactivated at this specific time (red bars in the screenshot

below), regardless of when it had been activated. You can specify a maximum of four

entries (periods of time or end time).

Office mode is automatically canc elled, or not started , on public holidays, in the event of
"Battery empty" warnings, if the locking component time is incorrect and also during
firmware updates.

Access

Office mode Permit manual office mode
Enables manual office mode with authorised media (smartphones, cards, key tags)

AuinesicSificsmode Activate automatic office mode
Activates the automatic office mode and end times for the manual office mode, with which the locking component opens or closes

Monday Tuesday Wednesday Thursday Friday
i I \

07:15- 15:45 07:15 - 15:45
Open Open

i
16:00| | ‘
i
|
17:00) H ‘F
i
I 1

I
1000l

= Add automatic office mode = Add end time for the manual office mode

Release duration 5 s normal release duration

20 s extended release duration

Figure 120: Automatic office mode

Manual office mode can  also be activated using identification media. In this
process, hold the identification medium to the locking component, briefly
remove it from the reader area and once again hold it to the reader for a

second time during the release duration. Proceed ident ically to end manual
office mode.
The release duration specifies how long the locking component s unlocked when using a

locking component  (i.e. within the context of cylinders this is the period users have to
manually turn the cylinder & thumb turn). Th e standard release duration is 5 seconds and
the extended release duration amounts to 20 seconds. Adapt the release duration
individually here. The period can be adapted between 1 second and 250 seconds.

The Update after each unlocking option can be used to activate whether the locking
component should be updated after each successful Bluetooth unlocking operation.
Regardless of this, the locking component is updated each time it is unlocked with a
smartpho ne via Bluetooth, if at least 6 hours have passed since the last complete
actualisation.

This update is not visible to the user. Neither a signal is shown nor a message is displayed
on the smartphone.

The action can be seen from the administrators in the event log of the online
adminis tration.
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L'j' 010DACAB298ATFIC (Sa... iy Locking component updat... £ Event log updated =3

L: D10DACAS298ATFIC (Sa... o Access granted| & Locking component updated after unlocking via Bluetooth

Figure 121: Eventlog - Update after each unlocking

After a Bluetooth unlocking operation, only the following data will be updated

1 Blacklist

i Timezone
1 Time

1 Eventlogs

If the locking component has other open maintenance tasks, these must be
updated as described in the chapter Updating locking components

The function depends on the connection quality of the smartphone. Therefore,
make sure that you have a stable Internet connection starting with 3G or via
WIFI.

The update after a Bluetooth unlocking operation will also be performed when
starting the manual office mode, but not when it is ending.

The update after a Bluetooth unlocking process takes place within the release
duration of the locking component. If the release duration is less than 10
seconds, the update after a Bluetooth unlocking may not work. For this
reason, when the function is act ivated, the value of the normal release
duration is automatically set to 10 seconds.

Activating this function increases the battery consumption of battery -
powered locking components, such as an AirKey cylinder, and thus affects
battery life.

@ 00 O

Logging

Select the default value for personal event log entries within the context of access events.
Three radio buttons are available for this purpose:

Logging
@ visible
Personal reference in protocol _
entries - Visible for Days
D Not visible

Figure 122 : Defining logging / event logs

Visible permanently switches on the display of personal data for access events.
Visible for é d a yrenders personal data for access events anonymous after the
defined number of days.

Not visible  immediately renders all personal data for access events anonymous.
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Specified default values can be changed for individual locking component s,
regardless of the settings specified here.

Clickthe Save button to save changed default values. For this p urpose, a prompt appears
asking to specify whether the changed default values must exclusively apply to recently
added or all locking component  s.

Save changed specification values

‘Would you like to save the following changes to spedification values?

o Office mode

o Logging

© Public holiday calendar

Changed spedification values will be used if you add a new component to your
access control system. Would you like to additionally transfer the changes to all
components that have already been areated within your access control system?
@ Use the change as specifications for the recently added components only.
©) additionally apply changes o all my locking components.

X cancel B save

Figure 123: Save changed specification values?

5.4.3 Public holidays

Define up to 80 public holidays per year in the Public holidays tab (current year and two
following years). In AirKey the term "Public holiday" can be interpreted as a general bank

holiday or a period of several days, such as company holidays or school holidays (may
reoccur). For instance, specify that a national, pub lic holiday falling on the same date each
year is re -entered each year. One week of school holidays merely counts as one public
holiday in the system if the period was defined with between "Start T End".

Effects of the public holiday calendar:
1. Periodic ac cess authorisations are not valid on public holidays.
2. Automatic office mode is not taken into account on public holidays.

Click the Activate button on the right -hand side to globally enable the public holiday
calendar.

U Actiate

2. Astomatic office mode i ot taken it accont on publc habdays

o Akt putiic holidey | 73 svailable 12017y [fCender view [0 Lt view

nunxaan

Figure 124 : Public holiday calendar (calendar view)
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Click the Add public holiday button or click the exact date of the public holiday in the
calendar view (e.g. 24/12) to open a dialogue window to enter the name of the public
holiday, specify whether the public holiday applies for the entire day or, e.g. the afternoon
only, and between which periods the public holiday applies (e.g. also specify company
holidays here), define how many times it reoccurs and when the specification no longe
applies.

Add public holiday

*MName  Christmas Eve
all day
*start | 241202017 [ |

*End | 24M22017 [

Repetition Each year -

INever expires

X cancel [ save

Figure 125: Adding public holidays

You can retrospectively edit each entered public holiday. For this purpose, simply click the
corresponding day to open a text box.

October November

MO TU WE TH FR SA SU MO TU WE TH FR SA SU
1 1/ 2/2|a|s5s

2|3 4J T-_g 101112

g 10 11J Nafiongjeieriag 7 & 16 17 18 19

Add public holiday -

16 17 1s| 23 24 35 26

23 14;-11&_,1?'23'29' 2728 20| 30

30 N e

Figure 126 : Adding public holidays in the calendar
Clickthe Add public holiday link to add a further public holiday on this day. You can enter

several public holidays on one calendar day. Click the pen icon to edit the public holiday.
Click the bin to delete the public holiday.

Edit public holiday

The "Nationalfeiertag™ public holiday is a series of dates.
Do you want to edit this date only (starts on 26/10/2017) or the series of dates (this and all
future dates)?

M cancel =p The series of dates =p This date only

Figure 127 : Editing public holidays

access to security
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Delete public holiday

The "Nationalfeiertag™ public holiday is a series of dates.
Do you want to delete this date (starts on 26/10/2017) only or the series of dates (this and all
future dates)?

x Cancel W The series of dates @ This date only

Figure 128: Deleting public holidays

As soon as you have entered deadlines, (company) holidays or public holidays in the
calendar, the system shows you a list overview of all saved public holidays, etc.

(EVVA) AirKey L T -

f HOME G ACCESSCONTROLSYSTEM Rt MmEDiAGPERsoNs [ PROTOCOLS  Jo ADMINISTRATORS @) HELP
Settings

Genersl | Specticaton values | Pube holdays

Public holiday calendar e
B e ot = s s e
o Add public holiday 72 awailabile 12017 159 Calendar view B st view
Pt oo A g Sme ot ados ey doon S iy o S anaon soon
g;;:;::wﬂw Repetition: Each year, Meves expires. Repetition: Each year, Never expaes. Repatition: Each year, Never expines. Repetition: Each year, Never expires. Repetition: Each year, Newer expires. Repetiton: Each year, Newer expires.
i -,
o Add public hoiday 72 awailable
© Desctivate.
Figure 129: Public holiday calendar (list view)
Select the Deactivate  button to globally deactivate the public holiday calendar for the
access control system  and not save it for added locking component  s.
55 Access control system
Thanks to the tiles on the Home screen as well as the menus and sub -menusinthe Access
control system main menu you can manage your electronic access control system.
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I Access control system o Add
3.‘, g
2 Cylinder 1 Wall reader 4 Areas
Door designatis Comp D Maintenance tasks
Door 2 000565F246DF929A Y .
1 Maintenance task

AirKey

ﬁ HOME B ACCESS CONTROL SYSTEM &t MEDIA & PERSONS a PROTOCOLS :a ADMINISTRATORS 0 HELP

Home Locking components abl e editing of your Airkey access
» Add locking component ontrolsystem
Areas
3 Create area
Maintenance tasks @
Customer details %
"Send a Key™
Figure 130: Access control system
5.5.1 Locking component overview
For an overview of all locking component s within your access control system  from the
Home screenclickthe Cylinders or Wallreaders  tileorgoto Access control system ->
Locking components  inthe main menu. The Home screen shows how many cylinders or
wall readers have been integrated into your access control system  at a glance.

All locking component s with additional information as well as their status are listed. The
first row of the list features the search field a s well as filter functions for locking
component s.

f HOME @ ACCESSCONTROLSYSTEM  B% MEDIA G PERsONS [ PROTOCOLS  Jo ADMINISTRATORS @ HEW

Locking components

o O o o

AT G e hamel® v St el
- R = 3 - y ®
et s o | = - = . -
At locking component Fagont e

Figure 131 : Locking components
> "Only own" - exclusively lists your own locking component s
> "Only external" - exclusively lists locking component s that have been authorised

by an administrator.

> "Only current” ® exclusively lists locking component s where the status is up to date
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> "Notcurrent" — exclusively lists locking component s where the status is not up to
date.
> Export the locking component listto a CSV file for further processing °.
AirKey allows an authorisation of locking component s for external access
control system s. The list differentiates between your own and external locking

component s. Please refertothe  Sharing locking components _ for other access
control system s section for more detailed information.

5.5.2 Adding locking components . See Section 4.11 4.11

55.3 Editing locking component S

The Edit locking component application window in the Details tab provides different
information, such as component type and model, component ID, firmware version or

component status as well as information about doors, areas and authorisations. You also

hav e the option here to show locking component  locations in Google Maps.  The Settings
tab shows all configured settings relating timezone and public holiday calender , access as
well as eventlog and repair options

The battery status shown corresponds to t he status at the last update or the
last transferred event log entry. For this reason, the actual battery status of

the locking component  may deviate from the battery status shown in the
AirKey online administration.

> Onthe Home screen,clickthe Cylinders or Wall readers tile

> Alternatively, select  Access control system - > Locking components in the main
menu.

> Click the locking component you would like to edit in the list.

> For instance, assign an optional door designation in the Details tab add optional
information - or enter the location or address of locking component s. The unique
characteristics of this data are verified within the access control system

(EVVA) AirKey

# vome @ AccessconTROusYSTEM Lt meiagPersons  [B) PROTOCOS S ADMINISTRATORS (@) HELP

Edit locking component ik || Remow

44, Thumb turn version 4 54, Bectronics module version 4 54
tatus from OMIIA0NT 1250.77) (5 Tene comect @ Cumend time zone i3, Backistup todate 8 Areas up to date  Corment relense duration [ Office mode settings up 1o date [ Public holiday calenddar up to date -, Firmware up to date

Figure 132: Editing locking component s
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> Gotothe Areas section to edit assigned areas for selected locking ¢ omponent s.

=

A Only not cument @)
s designation ~ Area status

Feuerwche

©

Show 110 2 o 2 entres

+ Assign to areas

Figure 133: Areas

> You can optionally also authorise locking component s for other access control
system s. You can manage the corresponding authorisations in the "Authorisations”
section. Please refer to the Working with several  access control system s section for
more detailed information about authorisations.

AllfE)  shares ) Shose codes (0}
access cantrol system ~ | Customer mumber Released since Share code (valid unti)
Na dsta found

Show 0100 of @ entries

4 Add share

Figure 134: Shares

> You can optionally enter a comment on a locking component in the Remarks
section.

emarks

Comment

Figure 135: Editing locking component s

As mentioned above, you can manage time zones and public holiday calender , access or
eventlog and repair options inthe Settings tab.

> If you operate several time zones within a single access control system , you can
assign an individual time zone (which has already been created and configured in
the online administration) to each locking component . The default time zone is used

as standard.

> |n this process, you can (de)activate the public holiday calendar for each locking
component . Thereis alink to the public holiday calendar in case you need to double -
check on some public holiday settings.

Time and calendar

Time zone Europefienna +~ UTC+02:00
Public holiday calendar  [C] Apply public holiday calendar = Go to public holidays settings

The following exceptions are controlled by the public holiday calendar:
1. Periodic access authorisations are not valid on public holidays.
2. Automatic office mode is not taken into account on public holidays.

Figure 136: Settings i time and calendar
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> You can specify manual office mode for each locking component . Select a locking
component and you will have the option to specify automatic office mode.

In addition , you can change the release duration and activate o r deactivate the
AUpdate after each urPlease dsb refgrdo fDefault valuesr(for all
recently added locking components ).

> You can adapt personal event log entries for each locking component . The default
settings are used as standard.

1 Visible permanently switches on the display of personal data for access
events.

1 Visiblefor ¢é d a yenders personal data for access events anonymous
after the defined number of days.

1 Notvisibl e immediately renders all personal data for access events

anonymous.
Logging
@ visible
Personal reference in protocol _
entries ' Visible for Days
©) Not visible

Figure 137: Eventlogs

> This section provides the link to the repair options. Further details you can find in
chapter Repair options

> Click Save to confirm any changes to the locking component . A confirmation
prompt subsequently appears.

A maintenance task for this locking component  may appear depending on the
locking component  data you edited. The changes are accepted and the
maintenance task disappears after having updated the locking component
using a smartphone with maintenance aut horisation or a coding station.

554 Removing locking component S

You can remove locking component s from your access control system if you no longer
require them in your access control system

> Onthe Home screen, selectthe Cylinders or Wall readers tile.

> Alternatively, select  Access control system -> Locking components inthe
main m enu.

> Click the listed locking component  you would like to delete from your Airke y
system.

> Click Remove - atthe top right.
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AirKey st | g g | 43 s | ] oot

# HoME @ ACCESSCONTROLSYSTEM At MEDIAGPERsONs [} PROTOCOLS  Jo ADMINISTRATORS @ HELP
Edit locking component P s,

Detsts | Settng: thorised medkt fown) | Authorised redia (extesl

Java Card applet 644, Thumb tum version 454, Electronics modube version 454
I Battery 0K (stotus from 03072017 12:5027) (i Time comect 5 Current ime zone 5 Blackist up to date 53 Aress up to dote = [72 Public holidsy wptodate L

031072017 12:5027

Figure 138: Removing locking component s

> Click Remove locking component to confirm the security prompt.

Remove locking component

Do you really want to remove the locking component “Door 17 from your access control
system?
The locking component will be removed and reset to construction site mode.

Existing authorised media can no longer unlock these locking component.

® cancel # Remove locking component

Figure 139: Security prompt

> A confirmation prompt and a maintenance task appear, indicating the locking
component must be removed from the access control system

The process has only been  completed once the  locking component  has been updated using
a smartphone with maintenance authorisation or an optionally available coding station. As

soon as the locking component  has been updated it has been successfully removed from

the access control sy stem .

This process is irrevocable.
The locking component s reset to factory state after having removed it.

Any previously authorised access media are no longer valid to unlock locking
component s. Corresponding authorisations are automatically deleted and no
longer shown.

5.5.5 Areas

You can merge several locking component s to areas to make it easier to manage
authorisations in your ~ access control system

On the Home screen, clickthe Areas tile or select Access control system -> Areas in
the main menu for a list of all areas including their individual states.

The list of areas enables the following adaptations:

> Enter a search term with a minimum of three characters in the search field — .
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> Click the corresponding column heading to determine it as the sorting criterion.
> Export the area list to a CSV file for further processing - .

AirKey o p—

A HOME () ACCESSCOMTROLSISTEM LU MEDIAGPERSONS  [§) PROTOCOLS  Jp ADMINISTRATORS () HELP

cocoe|;

@
Figure 140: Access control system - > Areas
> Select the desired area from the list to view the details of the selected area.
5.5.6 Creating areas

No areas have been defined as standard. You must create new areas to be able to add
locking component s to areas.

> Onthe Home screeninthe grey Access control system section, click Add ->
Create area

> Alternatively, select  Access control system -> Create area inthe main menu.
> Specify a unigque designation for the area.

> Document any additional information on the area in the Comment field of the
Remarks section.

> Click Save -.

Airkey s 4 o

A HOME @ ACCESSCONTROLSYSTEM L MEDAGPERSONS [ PROTOCOLS B ADMINISTRATORS () HELP

p— e =@

Detais

i locking compencaty

You can i kg crmponents 1 the ares s the Save

Figure 141: Creating areas

The system reports "Area saved successfully" once you have created an area.
You can only add locking component s to areas once they have been
successfully saved.

5.5.7 Assigning  locking component s to areas

> Onthe Home screen selectthe Areas tile orclick Access control system ->
Areas in the main menu.
> Select the area from the list to which you would like to add locking component  s.
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> The details of the selected area appear. Area status - indicates whether or not
all locking component s within the area are up to date. The Assigned  locking
component  list - lists all locking component s assigned to the area.
> Click Assign component ® to add a locking component to the area.
AirKey o S Enoiih -

# voui @ AcsscoNROLSYSTEM AL wiDmGPoRsoNs [ FROTOCOLS s ADMINISTRAIORS @) HELP

Edit area ¥ eiction ek || P sne

Heaaquanes

4% At least one locking component is not up to date

vt ki compns €

v A componentpes - AUl o Ovly camera (@) Only not cmrent (1)
Doar designation fadditional information) ~ | Camponent type Companent 1D Number of areas Eattery status Compunent stats
oo 2 T Wall eader 000SESF24EDFI29A [ ¥ )

Show 1101 af 1 eores

S Yop—

Remarks

Figure 142: Editing areas

Alist of all locking component s that have not yet been assigned to this area appears.

Assign components

Select the locking components that are to be assigned to the area. Persons that are authorised for the area can block these components.

Locking components
Door designation (Additional information), Component ID All componenttypes -
Door designation (additional information) # | Component type Component ID
1] Door 1 a Cylinder 000508E2C227AD98 -
= Door 3 Cylinder 0005DFOETB14013E -

Show 1 to 2 of 2 entries

You have to update the components before they can be used in the area.

¥ Gncel

Figure 143: Assigning components

> Select the desired locking component s (multiple locking component  selections
(also different types) are possible).

> Click Assign components to assign the locking component s to the area.

> Click Save to confirm the changes.

Maintenance ta sks are created for the affected locking component s that are deleted from
the list by updating the corresponding locking component s using a smartphone or coding
station. You have completed assigning locking component s to areas after having updated.

A locking component  can be assigned to a maximum of 96 areas.

Alternatively, you can also directly edit the area assignments of locking
component s in the locking component details. Please refer to the Editing
locking components  section for more detailed information.
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5.5.8 Cancelling locking component assignments to an area
Proceed as follows to cancel assignments of one or more locking component s to an area:
> Onthe Home screen selectthe Areas tile orclick Access control system ->

Areas in the main menu.

> Select the area from the list in which you would like to cancel the locking
component assignment.

> Tick the check boxes 0  fthe locking component s for which you would like to cancel
the assignments to areas. You can select multiple entries.

AirKey Mo oy ger v ) s ] oa

# HoME @ ACCESSCONTROLSYSTEM  R& MEDAGPERSONS [ PROTOCOLS  J ADMINISTRAIORS @) HELP

Edit area T ek || M s

wion | Heatquantsr

5 3% Atleast one locking component is not up to date.

A ke king compornts

Al componenttipes - AL o Ovly cument (B) £ Oy o current (1)
Door designation (additonsl informatice) ~  Component type Comganent B Murmber of areas Batiery siatus Component statis
¥ Door 2 Wall eacker [rrmmr— . ¥ [
Show 1101 of 1 entres

4 s compenens || cance g 1) )
Figure 144 : Highlighting locking component s

> Click Cancel assignments -,

> A dialogue window appears that once again lists the  locking component s for which

the assignments to an area are to be cancelled.

> Also confirm this dialogue with Cancel assignment

Cancel assignment

Do you really want to revoke the locking component assignment? Persons that are authorised for the area can no longer
block them.

- D00565F246DF929A. Door 2 r

You must update the companents in order to fully remove the assignment.

¥ cancel W cancel assignment (1)

Figure 145: Cancelling assignments

Maintenance tasks are created for the affected locking component s that are deleted from
the list by updating the corresponding locking component s using a smartphone or coding
station. You have completed assigning locking component s to areas after having updated.

After having updated, person s with media featuring authorisations for this
area will be unable to unlock the locking component  for which you cancelled
the assignment.
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Alternatively, you can also directly edit the area assignments of locking
component s in the locking component details. Please refer to the Editing
locking components _ section for more detailed information.
5.5.9 Deleting area
> Onthe Home screen selectthe Areas tile orclick Access control system ->

Areas in the main menu.
> Select the area you would like to delete from the list.

> Click Delete -.

AirKey

f HoWE @ ACCESSCONTROLSYSTEM % MEDIAGPERSONS [ PROTOCOLS  Jo ADMINISTRATORS (@) HELP
Edit area

Details

* Ava designation | Headaquarter

fuea stz 39 At least ane locking component is not up to date.

Assigned kocking components

Al comganentipes
Door desiguation (additionalinformation) ~ | Component type Companent 1D
7 Door 2 T Wall reader 00D565F246DFI29A

Show 1101 0f 1 enres

o Assign components W Cancel assignment (1)

Humber of areas

4

English - Settings Logoft

Q¥ ren

ok || [ s

Al o Onlycument (0} £ Only not curent (1)
Component status

(7]

Figure 146 : Deleting areas

Any existing authorisations on media for a deleted area are automatically

deleted and no longer

An error message appears if locking component

Delete area — not possible

A locking comp it is still assi to the " ter” area.
- 000565F246DF329A: Doar 2

Please remove the assignment of the component first.
The area has not been deleted.

shown. Deletion is irrevocable.

x Cancel

Figure 147: Deleting areas 1 not possible

For this reason, initially cancel all locking component

component assignments to an area
locking component s to areas .

5.5.10 Authorisation overview

s are still assigned to the/this area.

assignments to the area and
subsequently repeat the illustrated process. Please refer to the

Cancelling

locking

section for more detailed information

The authorisation overview shows all authorisations of media for each individual
locking component

component . The authorisation overview relates to the selected

on as signing

locking
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All media with  authorisations for this locking component  are listed. However,
the authorisations displayed must not necessarily be currently valid, i.e.

media with tem porary, single access between 8 am and 5 pm will also be
displayed for locking component s after 5 pmin the authorisation overview.

> Onthe Home screen, selectthe Cylinders or Wall readers  tile or click Access
control system -> Locking components

> Selectthe locking component for which you would like to view the authorisation
overview from the list.

> Browse from the Details tabto Authorised media (own) to view the
authorisations of your own system or select Authorised media (external) to
view authorisations from other systems for which the locking component  has been
authorised.

AirKey

# HOME {3 ACCESSCONTROLSYSTEM Q% MEDIAGPERSONS  [E) PROTOCOLS Qs ADMINISTRATORS () HELP

Edit locking component
Details | Settngs | Authorised media {own) | Authorised media (external)

Details

Figure 148: "Editing locking component s" page tabs

You are provided with a list of all persons as well as the associated persons. You can also
view the media type.

Figure 149: Authorised media (own)

You can search, filter or sort this list to view certain authorisations.
Click a person & name to directly view this person & authorisation for the
medium.
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